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Use the following sections to find information on assembly 
modelling: 

Introduction to Assembly modelling (see page 3) 

Component definitions (see page 22) 

Power Features (see page 46) 

Assemblies and Sub-assemblies (see page 79) 

Components (see page 85) 

Parameterised Components (see page 117) 

Exploding assemblies (see page 123) 

Schedules (see page 124) 

Adding components using the Component Wizard (see page 126) 

Assembly options (see page 138) 
 

Introduction to Assembly modelling 
Use the following sections to find information on assembly 
modelling: 

 What is Assembly modelling? (see page 4) 

 What is a component definition? (see page 4) 

 What is a component? (see page 5) 

 What is an assembly? (see page 5) 

 What is an attachment? (see page 5) 

 What is a relation? (see page 6) 

 What is a sub-assembly? (see page 6) 

 What is a group? (see page 6) 

 What is a sub-item? (see page 6) 

Assembly modelling 
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 Starting Assembly modelling (see page 7) 

 Assembly tree (see page 9) 

 Assembly modelling menus (see page 17) 

 How do I find information about assembly objects? (see page 21) 
 

What is Assembly modelling? 
Assembly modelling allows you to generate complex assemblies of 
standard components, quickly and easily. 

Assemblies are built from components. You can register solids as 
component definitions and then create many instances of the 
components in the assembly. 

For example, a car can be an assembly consisting of four wheel 
components and one body component. Each wheel component is 
created from the same wheel component definition. The body 
component is created from the body component definition. 

Generally, an assembly is: 

 a set of components 

 a set of relationships, defining how components fit together 

Assembly modelling includes various tools that help a user to 
analyse the assembly that is created. 

 

What is a component definition? 
PowerSHAPE comes with several pre-defined graphical object types 
(such as lines, arcs, curves, surfaces and solids) that you can create 
to represent real objects or features of real objects. 

A component definition is a user-defined graphical object that you 
can use to represent complete engineering components. 

A component definition is only a mechanism for storing the 
geometry and not an actual instance of an object. It is created 
automatically when you create a component from a selected solid 
and stored invisibly. Once a component definition is created, you 
can use it to create components and build the assembly. 

For example, you can create a component called wheel. When you 
create this component, a corresponding component definition will be 
created to contain the geometry of the wheel. To create a car 
assembly, you will also need  a body component that contains the 
geometry of the car body. For further details, see What is an 
assembly? (see page 5) 
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What is a component? 
To create a visible object from component definition within 
assembly modelling, you must create instances of the component 
definitions in particular positions and orientations in your model. 
These instances are simply called components. 

For our car assembly, we can create four identical wheels 
components from the one component definition of the wheel. The 
body component is created from the component definition of the 
body. 

 

What is an assembly? 
An assembly is a collection of components which fit together. 

In the car assembly, you can create four wheel components and a 
body component. The assembly would also store information on 
how these fit together to create the car. 

 
 

What is an attachment? 
Components can be attached to other components in an assembly 
using attachments. These are planar faces, axis, straight edges or 
points on components where another component can be attached. 

When you register a component, all the possible attachments are 
found automatically. 

In the example below, the attachments will be generated as follows: 

 Plane 

 Line 

 Point 
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What is a relation? 
A relation is a relationship between an attachment on one 
component and an attachment on a second component. For 
example, a planar attachment can be co-planar with another planar 
attachment, or it can be parallel by a given distance. 

 Relationships that define the position of the component itself 
(because it is attached to another component) are called Slave 
relationships. 

 Relationships that define the position of other components 
(because they are attached to a master component) are called 
Master relationships. 

The master relationship of one component is always matched by the 
slave relationship on the second (related) component. The 
relationship will be displayed twice: 

 In the Master Relations branch of the master component 

 In the Slave Relations branch of the slave component 
 

What is a sub-assembly? 
A sub-assembly is an existing assembly that forms part of another 
assembly. 

 

What is a group? 
A group is a collection of components in an assembly, but does not 
define an assembly hierarchy. 

 

What is a sub-item? 
For a component, the sub-item can be the main solid, power feature 
solid or the workplane of the component. 



 

PowerSHAPE 2015 R2 Reference Help Assembly modelling • 7  

For a sub-assembly, the sub-items are the components inside the 
sub-assembly. 

For a Group, the components are the sub-items. 
 

Starting Assembly modelling 
You can start Assembly modelling from: 

 the Main toolbar (see page 7). 

 the menu (see page 8). 
 

Using Assembly modelling from the toolbar 
1 Ensure that you have a model displayed. 

2 Select Assembly  from the main toolbar. The Assembly 
modelling toolbar will be displayed. 

  

 - Create new assembly 

 - Add component from selected solids 

 - Add component using the Intelligent Cursor 

 - Add components with advanced options 

 - Create component from selected solids with Power Features.  

 - Component wizard 

 - Add relationship using attachment 
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 - Manage attachments 

 - Generate Power Features 

 - Remove Power Features 

 - Show Power Feature Summary  

 - Show advanced Power Feature options 

 - Explode assembly using distance  

 - Explode assembly using angles 

 - Check components for intersection 

 - Manage source models of imported components 

 - Refresh imported components 

 - Convert all imported components to local 

When you enter Assembly modelling, any assemblies that 
already exist in the model are displayed in the assembly tree and 
all the buttons on the Assembly toolbar are active. 

3 Select the option you require from the toolbar. 
 

Using Assembly modelling from the menu 
1 Ensure that you have a model displayed. 
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2 Select Object from the main menu 

 
3 Select the option you require from the sub-menus. 

 

How do I exit Assembly modelling? 
From the Main toolbar, select another option. The selected toolbar is 
displayed. 

 

Assembly tree 
The assembly tree displays all the assemblies and solids in the 
model.  
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Each assembly contains all its components and the relationships 
between the components. In the example, there are two assemblies 
and two solids (26 and 27) that are not part of the assembly. 

 
 Expand — Click this button to expand the branches in the tree. 

 Contract — Click this button to contract the branches in the 
tree. 

 

Solids in the assembly tree 
The solid and assembly trees are amalgamated to provide an 
integrated product. Assembly and modelling functionality are 
available together in the tree window. 

 
A single solid that is not part of the assembly is displayed at the top 
of the tree.  

 
If there are several solids that are not part of the assembly, they 
are displayed in the Solids branch at the top of the assembly tree.  

 
 

Multiple selection in the assembly tree 
You can select multiple items in the assembly tree by using 
Ctrl+click or Shift+click. You can select multiple items of any of the 
following: 

 Assemblies  

 Components  

 Grouped Sub-assemblies 

 Power Features 
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Icons used in the assembly tree 
There are several basic icons that are used in the assembly tree: 

 Solids 

 Component 

 Assembly and sub-assembly 

 Group 

Associated parameters and relationships icons are added to the 
basic icons (see page 13). 

 An assembly is not shown in the assembly tree if it is included 
in another assembly, unless it is the active assembly. 

 

Basic assembly tree icons 
 Component name — If you select a component with the right 

mouse button, the following menu is displayed. 

There are four different states associated with components: 

 Component is a source of Power Features. It may apply 
these features into target components. 

 Component is a target for Power Features. Power Features 
from source components have been applied into it. The Power 
Features are all up to date. 

 Component is a target for Power Features. Power Features 
from source components have been applied into it. Some Power 
Features are out of date. 

 The Power Feature is out of date. 
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 Assembly name — This contains all the components and sub-
assemblies in the assembly. Right-click an assembly to display a 
menu with appropriate options active. 

 
If you right-click a sub-assembly, the following menu is displayed 
with appropriate options active. 
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 Group name — If Power Features applied in the group are out of 
date,  is added to icon. If you select the group with the right 
mouse button, the following context menu is displayed. 

 

 Master — This branch lists the relations in which the current 
component is master. Master components are highlighted in red 
(default colour scheme). 

 Slave — This branch lists the relations in which the current 
component is slave. Slave components are highlighted in green 
(default colour scheme). 

The details of the components in the  Master and  Slave 
branches are similar to that shown in the following example: 

 Coincident[0] bolt- This is a Line to Line relation of the current 
component with the component called bolt using the Coincident 
additional relation type. 

 Relationship — When you select a relationship in the tree, its 
attachments are highlighted in the assembly in the graphics 
window. 

 

Summary table of assembly tree icons 
The following table shows the different Assembly modelling icons 
and the associated parameter and relations icons. 
Components 

 
Power Features folder. 

  
Component has up to date associated Power 
Feature(s). It is a target component. 

 
Component contains Power Feature(s). It is a 
source component. 

  
An associated Power Feature is out of date. 

 
Component. 
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Imported component 

 Power Feature is out of date 

Assembly and Sub-Assembly 

 
Assembly. 

 
Assembly from another model. Use the 
Refresh imported component definitions to 
update the component definitions. 

 
Sub-assembly. 

  
Assembly contains Power Features. It is a 
source component. 

 
Imported assembly 

 
Group 

Parameters and relationships 

 
A parameterised assembly, component or 
component definition, depending on the 
associated icon. 

 
The component has no relationships. 

 The relationships of the component are under 
defined. 

 
There is a contradiction in relations. 

 
 

Sorting the assembly tree 
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You can sort the items on the assembly tree into alphabetical order. 
Click the right mouse button in a blank area of the tree and select 
Sort alphabetically. 

 
 

Assembly tree shortcuts 
Use the following Assembly tree shortcuts to quickly add a 
component in free space and modify a relationship.  

 Double-click on the component icon. The cursor changes to  
and the component graphics are displayed on the edge of the 
model window nearest to the cursor. 
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 Double-click on the relation icon to start modifying the 
relationship. 

 
 Double-click on the relation branch icon of a component to start 

creating a relationship with the master and slave components 
selected.  
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 You can use Ctrl+click to select multiple components in the 
Assembly tree. Right-click and Select is available on the menu. If 
you choose this option, the components you selected are 
highlighted in the model. 

 
 

Assembly modelling menus 
Related options are grouped together and are displayed in 
corresponding places on context menus, as follows: 

 
The exact composition of each menu depends on the object that is 
selected. 
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context menu: General options 

 
Combinations of the following options are displayed in the General 
options section of the assembly menus: 

 Cut  

 Copy  

 Paste  

 Paste Special 

 Delete  

 Next selection  

 Clear Selection  

 Select All  

 Blank 

 Blank Except 

 Undo 

 Redo 

 Selection 

 Selection Information 
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context menus: General Assembly options 

 
Combinations of the following options are displayed in the General 
Assembly options section of the assembly menus: 

 Activate 

 Create Component  

 Add to Assembly 

 Add to Assembly Advanced 

 Modify 

 Position 

 Geometry 

 Parameters 

 Properties 

 Modify Parameters 

 Modify Properties 

 All Instances  

 Modify Geometry 

 Modify Parameters 

 Modify Properties 

 Highlight 

 All 

 Similar 

 Convert   

 To Geometry 

 To Sub-assembly 
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 To Local 

 To Components 

 To Group 

 Convert to Local 

 Convert to Sub-assembly 

 Reassign 
 

Power Features options and Group options 

 
Combinations of the following options are displayed in the Power 
Features options section of the assembly menus: 

 Power Features  

 Generate 

 Remove 

 Preserve Source 

 Preserve Target 

 Target Flag 

 Group 

 Add 

 Remove 

 Rename Attachment 

 Drag and Drop mode 

 Category Name 

 Attribute  

 Power Feature Target 
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 Sectioned 
 

Style options 

 
Combinations of the following options are displayed in the Style 
options section of the assembly menus: 

 Use Style from Sub-Items 

 Use material from Sub-Items 

 Use Own Style 

 Use Own Material 

 Thumbnail size 

 Small  

 Medium 

 Large 

 Thumbnail Type 

 Wire  

 Shaded 

 Transparent Background 

 Update Thumbnails 

 Close Parent Library 
 

How do I find information about assembly objects? 
You can find information for the assembly objects by selecting 
Selection Information on the menu of the selected item. 

1 Right-click an assembly object in the assembly tree. 
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2 Choose Selection Information from the menu to display the 
Selection Information dialog.  

The dialog contains extra information for the assembly object as 
well as the usual selection information, including the dimensions 
of the bounding box for the selected components. 

 
 

Component definitions 
 Overview of component definitions (see page 22) 

 Working with multiple models (see page 23) 
 

Overview of component definitions 
A component definition is automatically registered when you: 

 select Create components from selected solids from the Assembly 
toolbar. 

 add a component by selecting Add to Assembly or Add to 
Assembly Advanced from the solid menu in either the assembly 
tree or the main graphics window. 

 Select From Selected Solids from the Component options of the 
Object menu. 

A component definition contains the geometry and attachments of 
the component. Attachments are automatically generated from the 
geometry and stored with the component definition. The Auto 
attachment factor is defined on the General page of the Assembly 
Options (see page 139). This factor is applied to the bounding box 
of the geometry of the component to create a new bounding box. 
Any attachments that lie within this bounding box are automatically 
included in the component definition. 
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Component definitions act like templates and are used to create 
instances of a component. Nearly all assembly operations are 
performed on component instances (components). Usually, 
component definitions are not visible to you, but there are two 
areas where you will use component definitions: 

 Component Libraries (see page 31) 

 Multi-model assemblies (see page 23) 
 

Working with multiple models 
This functionality lets you work with components that originate in 
different models. Multi-model groups together the functionality that 
handles working with components that originate in another model. 

To use the Multi-model options: 

1 Click  to display the Assembly modelling toolbar. 

2 Click  (Assembly modelling toolbar) to display the Multi-model 
flyout. 

3 Select one of the options from the flyout. 

 Manage source models — Change the source model for an 
imported component definition. For further details, see Managing 
source models (see page 23). 

 Refresh imported components — Updates the component 
definition to reflect any changes made to the component 
definition stored in the Component Library. For further details, 
see Manually refreshing imported component definitions (see 
page 26). 

 Convert to local — Convert all imported components to local, 
breaking the link to the original model. For further details, see 
Converting an imported component definition (see page 31). 

These options are also available by selecting Multi-Model from the 
Object menu. 

 

Managing source models 
You can change the source model for an imported component 
definition using the Manage source of imported component definitions 
dialog. This means that you can choose a different source model in 
a different location. This is particularly useful if the original source 
model has been renamed, deleted or moved to another location. 
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1 Select Manage source models of imported components from the 
Multi-model flyout. 

 
2 This displays the Manage source of imported component definitions 

dialog. This is the equivalent of selecting Manage source models 
from the Multi-model option of the Object menu. If the model has 
no imported component definitions then the dialog will not be 
displayed. 

 

Managing source models dialog 
Use this dialog to change the source model for an imported 
component definition. 
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Source models — The tree shows the list of the source models, with 
their associated imported component definitions. The icons on the 
left represent the imported definition and those on the right 
represents the definition in the source model. If the link between 
these is broken (for instance if the component definition in the 
source model has been renamed or deleted), the icon is changed to 
indicate the problem . 

Current: This displays information about  

 the component definition of the item that is selected in the 
assembly tree 

 the model selected in the Source models section. 

Path for search — Select a path from the drop down list or enter a 
path in the box.  

Browse — Displays the Choose path for source models dialog. The 
path that you choose in this dialog will be transferred to the Path for 
search drop down list when you click Select. 
Search source — Starts search for source models, using the path 
that you have selected in Path for search. Any source models that 
are found are added to the list in the Source models window. 
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Set as source — From the list displayed in the Source models 
window, select the appropriate source model for the definition and 
click Set as Source. 

OK — The selected source model is linked to the corresponding 
definitions. 

 

Imported component definitions 
You can synchronise an imported component definition used in a 
model with the version of the component definition stored in the 
Component Library. 

 

Automatic update of imported component defintions 
If you change a component definition stored in the Component 
Library and have not manually refreshed the imported definitions, 
opening or saving a model containing a component based on the 
original component definition, will display the Imported component 
definitions update dialog (see page 27). 

 
 

Manually refreshing imported component definitions 
When you change a component definition held in the Component 
Library, you can manually refresh imported definitions. Use one of 
the following methods to display the Imported component 
definitions update dialog (see page 27): 

 Select Refresh imported component definitions  on the Multi-
model  flyout. 

 Select Refresh imported definitions from the Multi-model option of 
the Object menu. 

Refreshing the imported definition checks that: 
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 the component definition exists. 

 the component definition used in the model is the same version 
as the component definition in the Component Library. 

 

Imported component definitions update dialog 

 
Component definition — The name of imported component definition 
that needs to be to synchronised. There will be an entry for each 
component definition that has been updated. 

Action — Select one of the following options to define how the 
component definitions are synchronised. 

 
 Copy from original — Replace the imported component definition 

with its original.  

 Copy to original — Replace the original component definition with 
the imported one.  

 Break link with original — Convert the imported component 
definition to local. From this point, the component based on the 
imported component definition will be unaffected by changes to 
the component definition in the Component Library. 

Change status — The status of the original and imported component 
definitions relative to each other. This will be one of the following: 

 Original — The original component definition has been changed.  

 Imported — The imported definition has been changed.  

 Both — The original and imported definitions have both been 
changed. 
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The following information about the selection is displayed below the 
list of component definitions: 

Name of current component definition  
Time of the last changed to this definition  
Name of original component definition  
Time of last change to the original definition  
Path to the model that contains original definition. 

OK — Component definition is synchronised. 
 

How do I synchronise imported component definitions? 
To see how synchronising imported definitions works using a 
component definition that is held in a Component Library, work 
through the following steps: 

1 Open a new model. 

2 Open a Component Library. 

3 Using a component definition from the Component Library, 
create a component in the model. 

4 Using the Open option of the File menu, open the library model 
of the component definition that you have imported into your 
model. 

5 Modify the geometry of the component definition; for example, 
move the hole. 

6 Save the library model. 

7 On your working model select Refresh imported components  
from the Multi-model flyout. The Imported component definitions 
update dialog (see page 27) is displayed. 

8 Select the option from the context menu that is displayed when 
you right click the Action heading.  

 
9 Click OK. 

The working model is updated. 
 

Checking imported component definitions 
When opening an assembly model imported component definitions 
are checked for the following problems: 

 Source model of the component definition has a version that is 
less than the current PowerSHAPE version. For further details, 
see Model has an earlier version number (see page 29) 
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 Source model of the component definition is not found at the 
expected disk location, or cannot be opened. For further details, 
see Component definitions are not at expected location (see page 
30) 

 

Model has an earlier version number 
When you open a model that contains component definitions where 
the source model is a different version of PowerSHAPE, a warning 
box is displayed. This lists 

 The models where the version number is not the current 
PowerSHAPE version. 

 The models that are used in the assembly but cannot be found at 
the expected locations. 

 
OK — Remove the component definition(s) from the current 
assembly. 

Cancel — Close the model. 
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Component definitions are not at expected location 
If the current model contains imported component definitions and 
the source model has been deleted or renamed, the Wrong source 
component definitions dialog is displayed. 

 
Path for search — The initial path that is searched for the model. 

Browse — Use the Browse for Folder dialog to choose the path to the 
correct source model. 

Apply path — The specified folder is scanned. If a required model or 
component definition is found in this folder, it is removed from the 
list in the dialog. 
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Converting an imported component definition 
You can convert an imported component definition into a local 
component definition by selecting Convert to local from the context 
menu for the imported component. 

 
In the example, the component 1_3 has been imported into the 
moldbase assembly. 

 

Component Libraries 
There are two types of Component Library: 

 Component Libraries supplied with PowerSHAPE. These are 
component libraries containing the component definitions of 
generic, standard-sized components for cap screws, shoulder 
bolts and dowel pins. 

 Component Libraries created by converting solids into 
components and saving the model as a component library to 
create a component library (see page 32). Those component 
definitions can be used in other assemblies as well. 

There are two context menus associated with a Component Library. 

 Single item context menu (see page 34) is displayed when you 
right-click on a library component. 
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 Component Library Window context menu (see page 39) is 
displayed when you right-click in free space in the component 
library window (not on a component). 

Using a component library 
If a component library exists, you can: 

 select a Component Library (see page 32). 

 display the Component Library window (see page 33). 

 add components to an assembly using the Component Library 
(see page 41). 

 add components to a Component Library (see page 42). 

 copy a component to another library, category or component 
library window (see page 45). 

 

Creating a Component Library 
To create a component library: 

1 Save your model, ensuring that the name is different from 
template names. 

2 Select Tools > Options from the menu. 

3 In the Options dialog, in Assembly options, select the Component 
Libraries page. 

4 Select This model is a component library. 

5 Save the model again. 
 

Selecting a Component Library 
1 Select File > Open Component Library from the menu. 

2 Select the component library you want to use. 

Component Libraries - A list of the Component Libraries. 

Component Definitions Preview - This displays the component 
definitions held in the selected Component Library. 

Name Filter - When the list of model names becomes very long, it 
can be difficult to find the model you want. Entering a filter 
reduces the list to only those models that match the filter 
pattern. For example, MOD* will show all libraries beginning with 
MOD. 

Clear - Clear the entry in Name Filter. 
Password - If the model is protected by a password, you will 
need to enter the password in here before selecting Open. 
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Browse - Use this dialog to select and open a library .psmodel 
file. 

3 Click Open. 
 

Displaying the Component Library 
To display the Component Library select View > Windows > 
Component Library from the menu. 

 
Unless all the component definitions have a category name, the tab 
in the Component Library window is unnamed. 

Each category name (see page 33) that has been used when 
creating the component definitions is displayed as a separate tab in 
the Component Library. 

Thumbnail images are displayed for all the component definitions in 
the Component Library. The tooltip for each thumbnail displays 
information about the library component. 

If there are more tabs than can be displayed in the window, you can 
scroll the tabs using the left and right mouse buttons: 

 Left click — Left-click on a scroll arrow to scroll through the tabs 
by a small, fixed amount. 

 Right click — Right-click on a scroll arrow to scroll through the 
tabs in larger steps. The size of the step depends on the width of 
the window and is approximately equal to the width of the tab 
area that is visible.  

Holding either mouse button scrolls through the tabs until you reach 
the last tab in the direction you are scrolling. 

 

Creating a category for component definitions in a 
component library 

Add a category name to a component definition to indicate the type 
of component definition. You can use the category name to filter the 
component definitions when adding a component. 

To add a component definition into a category: 
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1 Right-click the component in the assembly tree and select Set 
Category Name. 

The Set category name dialog is displayed. 

 
2 Select a category name from the list of existing category names, 

or enter a new category name. 

3 Click OK. 
 

Layout of the Component Library Window 

 
 Open Component libraries 

 Categories 

 Components 

The components in a component library are automatically arranged 
within the window so that only the vertical scroll bar is required. 

The default height of the component library window is a single row. 
If the window is bigger than this, the height is saved when the 
program is closed. 

 

Single item context menu 
One of the following context menus is displayed when you use the 
right mouse button to select a component in the Component Library 
window. The popup that is displayed will depend if the selected 
component is in the current model. 

 If the selected component is in the current model: 
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 If the selected component is in a library, but not in the current 

model: 

 
 If the selected component is in a library and in the current 

model: 
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 If the selection is an assembly: 

 
The options below are present on one or more of the context 
menus: 

Information - Displays the Selection Information dialog. 

Delete instances - Deletes the components in the model that have 
been created from this component. The component is also removed 
from the component library. 

Rename - Edit the name of the selected component in the 
component library 

Add to Assembly -  Use this option to position the component using 
the cursor. The cursor will change shape  and the component 
graphics will appear on the edge of the model window nearest to 
the cursor. Move the cursor to the required position and click the 
left mouse button. You can add multiple instances of the same 
component. When you have added all required components, click 

. 

Add to Assembly Advanced - Use this option to position the 
component using Insert axial component toolbar (see page 105). 
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Modify - Use these options to modify the component in the 
component library. This change will affect all instances of the 
component in all models that use this library. 

 

 Move the mouse over the context menu options to highlight 
the components that will be modified. 

Highlight All Instances - All instances of this component in the model 
are highlighted and the remainder of the model is dimmed. 

 
Category Name - Click on this to open the Set Category Name dialog. 
This lets you set the category name and changes the name that 
appears on the tab in the Component Library window. 
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Attributes - Set the attributes of the selected component in the 
component library. Any changes you make will affect all instances of 
the component in all models that use this library. 

 
 Power Feature Target - If selected, the component will be a Power 

Feature target (see page 48) 

 Sectioned - If selected, revolved components are sectioned when 
creating a Section View of the assembly in Delcam Drafting. 

 Use named attachment only - If selected, the attachments that are 
available during positioning operations (drag and drop, creating 
components on cursor and creating relations using relation 
toolbar) are restricted. If deselected, all attachments are 
available. 

Thumbnail View Direction - Use these options to set the view 
direction for the thumbnail for the selected item. The default 
viewing direction is defined on the General page of the Assembly 
Options. 

 
Close Parent Library - Close the library that contains the selected 
component. 
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Highlighting components using the Component Library 
popup 

Select the Highlight All instances option on the Component Library 
popup to highlight the components on the model that originate in 
the component library of another model. 

 

Selecting components using the Component Library popup 
Select components in the Component Library using standard 
Windows selection techniques: 

 If you select a single component with the mouse, you can add 
additional components to the selection by holding down the CTRL 

key and clicking a component  

 To add a range of components to the component you have 
already selected, hold down the SHIFT key and click another 

component  
 

Component Library Window context menu 
Use this popup to change the appearance of the Component Library 
Window.  

1 Right-click  in free space in the component library window 
(not on a component) to display the context menu. 

 
2 Select the option you require. 

Thumbnail Size — Choose the size of the thumbnails (Small, 
Medium or Large) that are displayed in the component library 
window. The default size is Large. 
Thumbnail Type — You can display the thumbnails in shaded or 
wireframe mode. The default setting is Shaded. 
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Transparent Background — If ON, the background of the 
thumbnails in the component library is transparent. If OFF, the 
background is coloured. 

Sort by — This lets you sort the thumbnails into alphabetical 
order. 

Rebuild Thumbnails — The thumbnails in a component library are 
automatically updated in the following circumstances: 

 A component is added to the active assembly 

 A component is removed from the active assembly 

 Changes are made to the geometry, category name or model 
definitions name of the active assembly. 

This means that the thumbnails of the component definitions 
of the active model are always up to date and do not require 
manual updating using the Rebuild option. However, changes 
to component definitions in the inactive libraries will not be 
updated automatically and will need to be updated manually. 

Enhanced Shading — If selected, photo-realistic shading is added 
to the thumbnails in the component library window. 

a Select Enhanced shading from the Component Library Window 
context menu to display the Enhanced Shading Options dialog.  

 
b Use the options to specify the enhanced shading for the 

components in the active model.  
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c Click Apply to apply the options directly from the dialog. 
Alternatively, apply the options later in the session by 
selecting Rebuild Thumbnails (Component Library Window 
context menu and Component context menu in the Component 
Library) 

Rename Category — Select this option to display the Set Category 
Name dialog and enter the new category name. 

 
Close all Libraries — Close all the open component libraries. 

 

Adding components to an assemby using the 
Component Library 

Add components from a component library to an assembly using 
one of the following methods: 

 Double-clicking the component (see page 41) 

 Using the context menu (see page 42) 

 You can use any component definition from any component 
library in another assembly. 

(a) Select the appropriate tab for the component library you 
want to use. 

(b) Double click the definition of the component. The 
component will be added to your assembly. 

 

Adding components from a library using double-click 
1 Ensure that the Component Library window is open, displaying 

thumbnail images of the components in the Component Library. 

2 Double click the thumbnail image of the definition of the 
component and it is positioned on the cursor using the default 
attachment. If you don't want to use the default attachment, try 
one of the following: 

 Hold down CTRL to flip the component orientation. 

 Press the up and down arrow keys to cycle through other 
attachments. 
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Adding components from a library using the context menu 
1 Open the appropriate Component Library by selecting the Open 

Component Library... from the File menu. 

2 Using the right mouse button, select a component in the 
Component Library to be added to the assembly. The popup that 
is displayed will depend if the selected component is in the 
current model. 

   

 

3 Select one of the following to add the component to the 
assembly: 

Add to Assembly -  Use this option to position the component 
using the cursor. The cursor will change shape  and the 
component graphics will appear on the edge of the model 
window nearest to the cursor. Move the cursor to the required 
position and click the left mouse button. You can add multiple 
instances of the same component. When you have added all 

required components, click . 

Add to Assembly Advanced - Use this option to position the 
component using Insert axial component toolbar (see page 105). 

 

Adding components to a component library 
Supplement a component library by: 

 adding components from the current component library to a new 
library (see page 43). 

 adding a component from the current model to a new component 
library (see page 43). 
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 adding a component from the current model to the current 
component library (see page 45). 

 

Adding components from the current component library to 
a new library 

1 Right-click  one or more selected objects in the Component 
Library window to display the Component library context menu. 

2 Select Add to New Library to display Select Library dialog. 

 
3 Enter the name of a new or existing library file. 

 

Adding a component from the current model to a new 
component library 

1 Right click  one or more objects in the graphics window to 
display the Component library context menu. 
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2 Select Add to New Library > New to display Select Library dialog. 

 
3 Enter the name of a new or existing library file. 

 
 

Adding a component from the current model to a new 
component library from the library window 

1 Right-click  one or more selected objects in the Component 
Library window to display the Component library context menu. 
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2 Select Add to New Library to display Select Library dialog. 
 

Adding a component from the current model to the current 
component library 

1 Right-click  one or more objects in the graphics window to 
display the Component library context menu. 

2 Select Add to New Library > Current to display Select Library 
dialog. 

 
3 The objects are copied into the current component library. 

 

Copying a component to another library, category or 
component library window 

1 Drag  the component so that the component is hovering 
over a vertical library tab or a category tab. The component 
library window that is displayed will reflect the position of the 
cursor. 
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 Adding a component to a category: 

 
 Adding a component to a library: 

 
2 When the correct library is displayed, release the mouse button.  

3 The component is added to the library. 
 

Power Features 
What is a Power Feature? 

A Power Feature Solid is a special solid for storing features 
associated with the component (Main Solid). There can be more 
than one Main Solid, but only one Power Feature Solid. 

 - Main solid. 

 - Power Feature solid. 
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 - The Power Feature is used to create fit/clearance for the main 
solid. 

 
A Power Feature is generated from a component. It is a second solid 
and is hidden unless the component or component definition is 
modified. 

The Power Feature contains features that are copied to any solid 
that intersects with the component when Generate Power Features is 
selected. Not all features may be defined as Power Features.  

 
Features that can be copied include hole, boolean, cut/boss and 
pocket/protrusion. When Power Features are applied, the name of a 
copied feature is based on the original name. For example, 

Power Feature name - HASCO Z41 fit hole  
Name of copied feature - HASCO Z41 fit hole_1 

Features that cannot be copied directly include fillets, chamfers and 
hollows. However, these features can be copied if they are applied 
to a feature that can be copied, such as a boolean 
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What are source and target components? 
A source component is a component that has a Power Feature Solid 
registered in its component definition. It will then apply these Power 
Features into any intersecting target components (for example a 
plate). The components marked with  on the model below are 
source components. 

A target component is a component that has intersections with a 
source component. The components marked with  on the model 
below are target components. 

 
 

Creating a Power Feature 
You register a Main Solid and Power Feature Solid as follows: 

1 Create the solids to be used in the assembly 

2 Select Assembly  from the main toolbar. The Assembly 
modelling toolbar will be displayed. 

3 Select a solid with the right mouse button to display the solid 
context menu. 

4 Select Add to Assembly Advanced to display the Add to Assembly 
dialog (see page 49). 

5 Use the dialog to register components, selecting the appropriate 
geometry for Main solid and Power Feature solid. 

 - Main solid. 

 - Power Feature solid. 
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 - The Power Feature is used to create fit/clearance for the 
main solid. 

 
 

Add to Assembly dialog 
This dialog is used to create a component from a solid and 
automatically register the associated component definition. It is 
displayed when you select Object > From Solids with Power Features. 

  
Name — The component is given a default name that is the name of 
the Main Solid. You can rename this if necessary. 

Select main solid — Select the component   

 
Select power features solid — Select the solid that stores the hole 
features associated with the Main Solid . The Power Feature is 
used to create fit/clearance  for the main solid. 

Advanced — Displays the Set Advanced property for Power Features 
dialog. 
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OK — Registers the component definition, removes the dialog from 
the screen and adds the component to the Assembly.  

 

Using a Power Feature 
1 Create a single component like the one below. 

  
2 Create a component for the Main and Power Feature solids 

 
3 Create an assembly consisting of the single component and 

several components that use the Power Feature component. 

 
 

Modifying a component definition for a Power Feature 
The model below shows a simple assembly called test. 

 The bolt component has been created with a main solid and a 
Power Feature. 

 The block is a single component. 
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You can modify the component definition for the component using 

 assembly tree (see page 51) 

 component library window (see page 52) 

  
1 Make the required changes to the geometry  

2 Select the  on the Modify toolbar. The solid converts back into 
the component  

 

Modifying the power feature using the assembly tree 
1 Right click the bolt component in the assembly tree to display 

the bolt popup. 

2 Using the popup, select Modify Geometry from the All Instances 
options. 

The geometry of the component definition is visible on the screen 
and the tree of the component definition is displayed. 
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3 Make the required changes to the geometry and select the  on 
the Modify toolbar. The solid converts back into the component  

 

Modifying the power feature using the component library 
1 Ensure that the component library window is displayed. If not, 

select Component Library from the Windows options of the View 
menu. 

2 Right click the component definition for bolt in the component 
library window to display the bolt popup. 

3 Using the popup, select Geometry from the Modify options. 

The geometry of the component definition is visible on the screen 
and the tree of the component definition is displayed. 

 

4 Make the required changes to the geometry and select the  on 
the Modify toolbar. The solid converts back into the component 
definition and is removed from the screen.  

All objects are visible again and the components that use the 
modified component definition are updated. 

 

Modifying a single component in the assembly 
To modify the component called bolt_1, 



 

PowerSHAPE 2015 R2 Reference Help Assembly modelling • 53  

1 Right click on bolt_1 in the assembly tree. 

 
2 Select Geometry from the Modify options on the popup.  The 

geometry of the component is visible on the screen and the 
assembly tree shows the power features and main solid. 

    
3 Make the required changes to the geometry. A message is 

displayed if you try to modify the geometry of a Power Feature 
Solid to include a feature that cannot be copied to the 
component. 

4 Select the  on the Modify toolbar. The power feature becomes 
hidden once more. 

 If you are using PS-Moldmaker components, you should 
modify the geometry by selecting Parameters from the Modify 
options, rather than Geometry. 

 

Adding and removing components and component 
definitions 

When you Modify a component or component definition, you can use 
the solid context menu, from either the graphics window or the 
assembly tree, to 
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 Add and remove a Main Solid (there can be more than one Main 
Solid) 

 
 Add and remove the Power Features Solid (there can only be one 

Power Feature Solid) 

 

 If you delete the component that is the origin of a Power 
Feature, the Power Feature is deleted. 
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Remove Power Features dialog 
This dialog is used to remove Power Features from the selected 
component. It is displayed if Show Generate Power Features dialog is 
selected on the General page of the Options dialog. 

 
Select target component(s) - If you displayed the dialog by selecting 

a target component (for example a plate), this option will have a  
and you will only need to select a source. 

If you didn't select a source component and therefore have only 
target components selected, all the components of the active 
assembly will become source components. In this case, clicking OK 
will remove the Power Feature for every instance of the target 
component(s) intersecting with a source component. 

Select source component(s) - If you displayed the dialog by selecting 
a source component (for example a screw), this option will have a 

 and you will only need to select a target. 

If you don't select a target component and therefore have only 
source components selected, all the components of the active 
assembly will be target components. In this case, clicking OK will 
remove the Power Feature for every instance of the source 
component intersecting with another component. 

If you select a source component that does not have Power 
Features defined: 

 an error message is displayed in the dialog. 

 the component is deselected. 

 the Swap button becomes inactive. 

If source and target components have been selected the power 
features in the selected targets will only be removed if they have 
been applied from the selected source components. This means that 
exactly what has been generated for a given selection in generate 
mode will be removed. 
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Swap - This option is only active if all selected target components 
also define Power Features. Selecting this option will have the 
following effect: 

Existing target components will become source components. 

Existing source components will become target components. 

Summary - This displays the Power Features Summary dialog so that 
you can see in more detail how the Power Features will be applied. 

Selection information - This panel displays information on the 
number of target and source components that have been selected. 
The following information panel shows that one source and one 
target component have been selected. 

 
If a source component was selected, but no target component, the 
message shows that all the components will be considered as 
targets. 

 
OK - Remove the Power Features where the target components 
intersect with the source components. 

Cancel - Close the dialog and cancel any changes you have made. 
 

Using the Power Features Summary 
You can specify how Power Features are applied by using the Power 
Features Summary. Work through the following example to see how 
you can use the Power Features Summary dialog to control the 
intersection of the target components with the source components. 

1 Create a plain moldbase and use Component Wizard to place 
some  screws. The example below uses four Hasco Z31 screws. 

2 From the assembly context menu, select Generate from the 
Power Features options 

The model and the assembly tree will be updated. 
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3 From the assembly toolbar, click Show Power Features Summary 

 or from assembly context menu, select Power Features - 
Summary. 
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The Power Features Summary dialog (see page 59) is displayed. 

 
4 Select a Source Component from the drop-down list and use the 

options on the dialog to make any changes.  

5 Click OK to save the Power Feature options that you 
selected/deselected. The options are applied and the Power 
Features are updated. The dialog is closed. 

If the Power Features Summary dialog was opened by selecting 
the Summary button on the Generate Power Features dialog (see 
page 71), this dialog will also be closed. 
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Power Features Summary dialog 
Use this dialog to choose how to apply Power Features. 

 
The default size of the dialog is changed to reflect the number of 
Power Features and target components. You can increase the size of 
the dialog, but you cannot make it smaller than the default size that 
is initially displayed. 

Power Features — The Power Feature solid of the source component. 
The tooltip displays the name of the Power Feature solid of the 
source component. This column displays: 

 Feature icon 

 Hole use (for example, Ejector pin clearance) for holes 

 Hover over the hole use to see the hole name is displayed 
on the tooltip 

 Feature name for features other than holes. 

Selecting a Power Feature from the list: 

 Highlights the row in the dialog. 

 Adds instrumentation to the Power Feature in the graphics 
window. 

 Highlights the target component in the graphics window. 
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For further details, see Highlighting Power Features. 

 
Apply to — Each Power Feature stores a rule defining how it should 
be applied.  These rules are based on the order in which the source 
component (for example, a screw) intersects with target 
components (for example, plates).  So, a screw will apply a 
counterbored clearance hole to the First plate it intersects with. 

Each source component has a direction vector used to order these 
intersections (displayed as a blue arrow on the Power Features 
Summary dialog). You can modify this direction using the Modify 
Direction button on the Set Advanced Property for Power Features 
dialog. The First intersection is the nearest point on the source 
component along this direction, the Last intersection is the furthest 
point. 

For a given set of intersections between the source and target 
components, this column shows how the Power Features would be 
applied. These options allow you to be more specific about whether 
or not a Power Feature is copied to a particular target component, 
based on the intersection order of the target components. The 
options that may appear in the column are explained in the 
following table. 
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Apply to Action 

 Copy feature onto all components. 

 Copy feature onto all components except the 
first one. 

 Copy on all target component except first 
and last 

 Copy feature onto all components except the 
last one. 

 Copy feature onto all components except the 
nth one. For example, if Number is 3, the 
feature will be copied onto all components 
except the 3rd. 

 Copy feature onto the first component only. 

 Copy feature onto the first and the last 
component. 

 Copy feature onto the first and the second 
component only. 

 Copy feature onto the last component only. 

 Copy feature onto the last and the last but 
one component only. 

 Copy feature onto the nth component only. 
For example if Number is 3, the feature will 
be copied onto the 3rd component only. 

 — Each target component that intersects with the source 
component is shown as a column on the Power Features summary 
dialog. The order of the target component columns is determined by 
the order in which they intersect with the source component. You 
can change the order that the target components intersect with the 

selected source components by using the Target Components  

 buttons. 

Selecting a target column, 

 Highlights the column in the summary 

 Highlights the target in the main graphics window 

 Adds instrumentation to all selected Power Features for that 
target 

Selecting an option in the target column, 

 Highlights the cell in the summary 



 

62 • Assembly modelling PowerSHAPE 2015 R2 Reference Help  

 Add instrumentation to the Power Feature in the graphics window 

 Highlights the target in the main graphics window 

 Toggles whether the feature is applied ( ) or not ( ) 

Source Components — Select a source component from the drop 
down list. If there are 4 bolts, there will be four options in the drop-
down list. Once you have chosen a source component, you can 
select the options for each Power Feature in the table for that 
component. 

 — All the option boxes are set back to the default as indicated 
by the source and target components in the assembly. If you have 
reordered the target components in the dialog, the rules will be 
applied in this order. 

 If the Power Features Summary dialog is activated from the 
Generate Power Features dialog, only the selected source 
components will be shown in the Select source component 
dialog. 

Group similar cases — If ON, similar source components are grouped 
together. Multiple components can then be modified by changing 
just one. 

The example shows four identical components.  

1 Open Power Feature Summary dialog. The Source Components 
drop down list contains all four components 

 
2 Set Group similar cases to ON. The Source Component drop down 

list now contains a single item. 

 
3 Turn OFF the Countersunk option in the Power Feature Summary 

dialog. The change is applied to all the components in the group. 
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Target Components — The appropriate buttons in this section are 
highlighted when a target intersection column is selected.  

 
Change the order that the target components intersect with the 
selected source components by using the following buttons. 

 — The intersections will be re-ordered and the current 
selection will be moved earlier in the order. On the dialog, the 
current target will be moved one column to the left.  

 — The intersections will be re-ordered and the current 
selection will be moved later in the order. On the dialog, the 
current target will be moved one column to the right. Clicking 
this button sets the target intersection to be the same as the 
previous intersection. 

 — Add the selected component as a target. The target is 
always added as the last intersection. You can the change the 
intersection order of this component and define how the Power 
Features are applied. This button is disabled if the selected 
component is already a target. 

 — Remove the selected target. The component will be 
removed from the intersection order and Power Features will not 
be applied to this component.  

You can make the target intersection the same as the previous (or 
next) intersection by using the following buttons: 
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 — Sets the target intersection to be the same as the 
previous intersection. The following example has three target 
intersection columns and illustrates  how this option works: 

1 Select column 2 

 

2 Click . The target intersection columns are updated; there 
are now two first intersections. 

 

 — Sets the later target intersection to be the same as the 
current intersection. The following example has three target 
intersection columns and illustrates how this option works: 

1 Select column 2 

 

2 Click . The target intersection columns are updated; there 
are now two second intersections 

 

 — Resets the target column order to the default and applies 
the default intersection rules. 

OK — Save the Power Feature options that you selected/deselected. 
The options are applied and the Power Features are updated. The 
dialog is closed. If the Power Features Summary dialog was opened 
by selecting the Summary button on the Generate Power Features 
dialog (see page 71), this dialog will also be closed. 
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Highlighting of components 
You can click on a row on column header in the Power Feature 
Summary dialog to highlight the corresponding item on the model. 
The cursor changes when hovering over an item that can be 
highlighted. 

 
Clicking on a row, column or cell will highlight the relevant 
components and features in the main graphics window as follows: 

Blue — Source component. This is a component that applies 
Power Features; for example, a screw.  

Yellow — Power Feature(s). 

Red — Target component(s). These are components that Power 
Features are applied into; for example, plates. 

In the following example, the first row has been selected in the 
dialog. This represents the tapped hole Power Feature. The Power 
Feature rule shows that this feature is Applied to the Last 
intersection only. The highlighting on the model reflects this: 

Blue — Screw  

Red — Last plate  

Yellow — Tapped hole feature  
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Identifying selected target components in the Power Feature 
Summary 

You can use the Power Feature Summary dialog from the Generate 
Power Features dialog to confirm that the Power Features will only 
be generated for a selection. 

1 Select your source and target components. 

 

2 Click the Generate Power Feature  button on the Assembly 
toolbar to display the Generate Power Features dialog. (see page 
71) 
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3 Select Summary to display the Power Features Summary dialog. 
Any unavailable intersections will be greyed out in the dialog. 

 
 

Updating the Power Features in your model 
If you add or remove a component from your model, you need to 
use Generate or Remove from the Power Features options to update 
the Power Features in the model. 

If you change a Power Feature and try to save the model, a 
message warns you that the definition contains features that are 

out of date. If you continue with the save operation, the  icon in 
the Power Features branch of the assembly tree will indicate the out 
of date Power Feature. The component that contains the out of date 
Power Feature is indicated by the  icon in the assembly tree. 

 
 

Updating Power Features - Adding a component 
You can do this in one of the following ways: 
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 Click  (Assembly toolbar). If components are selected, the 
Generate Power Features dialog (see page 71) is displayed. If no 
components are selected,  Power Features are generated for the 
active assembly. 

 Right click the assembly in the assembly tree and select Generate 
from the Power Features options on the context menu. 

 
This will update existing, out of date Power Features and will also 
generate Power Features for any new components for the entire 
assembly. 

 Right click the component in the graphics window and select 
Generate from the Power Features options on the context menu. 

 
This method can be used to generate or update Power Features 
for a sub-set of components. By default, the Generate Power 
Features dialog (see page 71) will be displayed.  
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When you select Generate Power Features, a new branch is added to 
the assembly tree. The status of the Power Feature is indicated by 
the icon that is displayed next to feature. 

  
 

Updating Power Features - Removing a component 
You can do this in one of the following : 

 Click   (Assembly toolbar). If components are selected, the 
Remove Power Features dialog (see page 55) is displayed. If no 
components are selected, Power Features are removed from the 
active assembly. 

 Right click the assembly in the assembly tree and select Remove 
Power Features from the context menu. 

 
This will remove the Power Features for the whole assembly 
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 Right click the component in the graphics window and select 
Remove Power Features from the context menu. 

 
This will remove any Power Features in the selected target 
component(s). 

 

Excluding components when generating Power Features 
Use the Power Feature Target option to exclude components when 
generating Power Features. This acts like a template for the 
component definition. So, if this option is changed, any components 
that are subsequently created will inherit the new setting. 

1 Open the appropriate Component Library. 

2 Right click the component definition in the component library 
window, to display the component definition popup. 

 
3 To exclude components using this component definition when 

generating Power Features, select Power Feature Target from the 
Attributes option of the component definition popup. 
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The default setting is ON. If you set Power Feature target OFF, 
you need to regenerate the Power Features to exclude the 
components from the assembly 

 

Controlling the selection of target and source components 
You can control the selection of target and source components 
before you generate the Power Features using the Generate Power 
Features dialog (see page 71). To display this, 

 Select a component on the model. Either click  (Assembly 
toolbar) or choose Generate from the Power Features options on 
the component popup.  

 Select an assembly in the assembly tree. Either click  
(Assembly toolbar) or choose Generate from the Power Features 
options on the assembly popup. 

When Power Features > Generate is selected from the component 
popup, the dialog is only displayed if Show Generate Power Features 
dialog is selected on the Tools > Options >Assembly > General dialog. 
The dialog is not normally displayed if the option is deselected. In 
this case, the component selection will be filtered automatically to 
identify which component is the target and which is the source 
component. However, the dialog will be displayed if a selected 
component could be either a source or a target. 

 

Generate Power Features dialog 
This dialog controls the selection of target and source components.  
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When Power Features > Generate is selected from the component 
popup, the dialog is only displayed if Show Generate Power Features 
dialog is selected on the Tools > Options >Assembly > General dialog. 
The dialog is not normally displayed if the option is deselected. In 
this case, the component selection will be filtered automatically to 
identify which component is the target and which is the source 
component. However, the dialog will be displayed if a selected 
component could be either a source or a target. 

 
Select target component(s) — If you display the dialog by selecting a 

target component (for example a plate), this option will have a  
and you will only need to select a source. 

If you don't select a source component and therefore have only 
target components selected, all the components of the active 
assembly will become source components. In this case, clicking OK 
will generate Power Features for every instance of the target 
component(s) intersecting with a source component. 

Select source component(s) — If you display the dialog by selecting a 

source component (for example a screw), this option will have a  
and you will only need to select a target. 

 If you don't select a target component and therefore have only 
source components selected, all the components of the active 
assembly will be target components. In this case, clicking OK will 
generate Power Features for every instance of the source 
component intersecting with another component. 

 If you select a source component that does not have Power 
Features defined, an error message is displayed in the dialog, the 
component is deselected and the Swap button becomes inactive. 

Swap — This option is only active if all selected target components 
also define Power Features. Selecting this option will have the 
following effect: 

 Existing target components will become source components. 
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 Existing source components will become target components. 

Summary — This displays the Power Features Summary dialog so that 
you can see in more detail how the Power Features will be applied. 

Selection information — This panel displays information on the 
number of target and source components that have been selected. 
The following information panel shows that one source and one 
target component have been selected. 

 
If a source component was selected, but no target component, the 
message shows that all the components will be considered as 
targets. 

 
OK — Generate the Power Features where the target components 
intersect with the source components. 

Cancel — Close the dialog and to cancel any changes you have 
made. 

 If you wish the Power Features to be generated automatically, 
do one of the following: 

•  Select Generate Power Features from Power Features sub-
menu on the assembly popup in the assembly tree. 

•  Select Tools > Option > Assembly > General and set the Show 
generate power features dialog option to OFF This will suppress 
the display of the Generate Power Features dialog. 

 

Preserving Power Features 
There are two Preserve options on the context menus for assemblies 
and components. They let you define if Power Features that have 
been applied to target component(s) are preserved when the source 
component(s) are deleted. 
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The following popup shows the options displayed on a component 
popup in the assembly tree. 

 
Preserve PFs source - If you select a source component and this 
option, any Power Features that the source component has applied 
to target component(s) will be preserved if the source component is 
deleted. 

Preserve PFs target - If you select a target component and this 
option, any Power Features that source component(s) have applied 
to the target component will be preserved if the source 
component(s) are deleted. 

 

Setting advanced properties for Power Features 
You can change the intersection rules associated with a Power 
Feature when modifying the geometry of a Power Feature solid. 

1 Select the required component in the assembly tree. 
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2 Right click the selected component in the assembly tree to 
display the component popup 

 
3 Select Geometry from the Modify options on the component 

popup. The component definition tree displays the Power Features 
Solid and Main Solids branches. 

4 Click  to expand the Power Features Solids branch. 

5 Right click the power feature solid to display the solid popup. 

 
6 Select Advanced Power Features to display the Set advanced 

property for Power Features dialog (see page 76). 

7 Use the dialog to change the intersection rules associated with a 
Power Feature. 
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8 Click OK. 

 If you have selected a single Power Feature source 

component, click  to display the Set advanced property for 
Power Features dialog (see page 76). This lets you define how 
the Power Feature is applied and modify the direction of the 
Power Feature. If you have not selected a single Power 
Feature source component, an error message is displayed. 

 
 

Set advanced property for Power Features dialog 
Use this dialog to change the intersection rules associated with a 
Power Feature. 

 
Power Features — This column contains a list of the Power Features 
for a source component. If you want to change the intersection 
rules associated with a Power Feature, select the Power Feature 
from the list. 

Power Features that have been suppressed using the Suppress by 
parameter option are displayed as shown below. 
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An unsuppressed Power Feature that is selected in the list in the 
dialog is highlighted on the assembly. 

 
Apply to — Each Power Feature stores a rule defining how it should 
be applied.  These rules are based on the order in which the source 
component (for example, a screw) intersects with target 
components (for example, plates).  So, a screw will apply a 
counterbored clearance hole to the First plate it intersects with. 

Each source component has a direction vector used to order these 
intersections (displayed as a blue arrow on the Power Features 
Summary dialog). You can modify this direction using the Modify 
Direction button on the Set Advanced Property for Power Features 
dialog. The First intersection is the nearest point on the source 
component along this direction, the Last intersection is the furthest 
point. 
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For a given set of intersections between the source and target 
components, this column shows how the Power Features would be 
applied. These options allow you to be more specific about whether 
or not a Power Feature is copied to a particular target component, 
based on the intersection order of the target components. The 
options that may appear in the column are explained in the 
following table. 
 
Apply to Action 

 Copy feature onto all components. 

 Copy feature onto all components except the 
first one. 

 Copy on all target component except first 
and last 

 Copy feature onto all components except the 
last one. 

 Copy feature onto all components except the 
nth one. For example, if Number is 3, the 
feature will be copied onto all components 
except the 3rd. 

 Copy feature onto the first component only. 

 Copy feature onto the first and the last 
component. 

 Copy feature onto the first and the second 
component only. 

 Copy feature onto the last component only. 

 Copy feature onto the last and the last but 
one component only. 

 Copy feature onto the nth component only. 
For example if Number is 3, the feature will 
be copied onto the 3rd component only. 

You can change the option that is shown in the Apply to column as 
follows: 

1 Click on the row that you wish to modify. 

2 Select an option from the Apply to drop down list. If you select 
Number or All but number from the drop down list, the Number 
option will become active. 

Number — Enter the number of the component that will be used by 
the Number or All but number rules. 
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Modify Direction — Modify the direction of the Power Feature using 
the Workplane dialog. 

 — Toggles the Intersection order label ON and OFF 
 

Assemblies and Sub-assemblies 
Creating a new assembly 

Before you can create components, you should create an assembly 
to hold the components. 

1 Click  to display the Assembly modelling toolbar. 

2 Click Create new empty assembly  to display the Create New 
Assembly dialog. This is the same as selecting the Object menu, 
followed by Assembly and then Create. 

3 Use Create New Assembly dialog (see page 79) to create a new 
assembly. 

 If an assembly does not already exist, it is created 
automatically when you select Create Component from the 
assembly tree or the component toolbar 
It is created with default name NNNNNN_assembly  
 
where NNNNNN is the name of model.   
 
For example, NEW_MODEL_1_11_assembly is the name of the 
assembly that is created from the model called 
NEW_MODEL_1_11. 

 

Create New Assembly dialog 
This lets you create a new assembly. 

 
Name of new assembly - You can enter the name of the new 
assembly in the text box. The drop down list contains the names of 
existing assemblies. 

Description - A description of the assembly may be optionally given. 
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Category name - Select a category name from the drop down list of 
existing category names, or enter a new category name in the text 
box. 

Create in a new model - If ON, the assembly is created in a new 
model when you click OK. 

OK - Creates a new assembly and removes the dialog from the 
screen. The new assembly appears in the assembly tree (see page 
9). You can now add components (see page 85) to the assembly.  

 

Editing an existing assembly 
As soon as you enter Assembly modelling, all the existing 
assemblies in the model are displayed in the assembly tree (see 
page 9).  

1 Before you can make changes to an assembly, you must make it 
the active assembly (see page 80). Only one assembly can be 
active at a time. 

2 Add a component or edit existing components. For further 
details, see: 

Creating components (see page 85) 

Adding an axial component (see page 90) 

Adding relationships between components (see page 91) 

Editing relationships (see page 106) 

Editing a component in the assembly (see page 109) 
 

Activating an assembly 
You can only edit an active assembly. To make any assembly active, 
right click its Assembly icon  and select Activate from the pop up 
menu. 

The components of the newly active assembly are now visible. 
 

Converting components into a sub-assembly 
You can create a sub-assembly from selected components by using 
the Edit menu or the context menus in either the assembly tree or 
the graphics window. Selected components can be: 

 One or more components. 

 One or more sub-assemblies. 

 A mixture of components and sub-assemblies. 
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When converting a group of selected components into a sub-
assembly, relationships will, wherever possible, be preserved as 
follows: 

 Relations between the selected components will be preserved. 

 Relations will be preserved in cases where the master component 
is a selected component and the slave component is not a 
selected component. 

 To avoid possible dependency loops, relations will be removed 
where the slave component is one of the selected components 
and the master is not a selected component. 

 

Creating a sub-assembly using the assembly tree 
1 Using the assembly tree, select the components to be included in 

the sub-assembly. 

2 Right click the selection to display the context menu. 

 
3 Select Convert. 

4 Select To Sub-assembly from the Convert options 
 

Creating a sub-assembly using the graphics window 
1 Using the graphics window, select the components to be included 

in the sub-assembly. 

2 Right click the selection to display the context menu. 
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3 Select Convert > To Sub-assembly from the options 

 

Using Sub-assemblies and Components 
You can apply assembly operations to components and sub-
assemblies using a context menu. 

1 Select your components and/or sub-assemblies 
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2 Click the right mouse button over the selection to display the 
context menu.  

 
 

How do I make a copy of a component or sub-
assembly? 

You can copy a component or a sub-assembly using the pop up 
menu in the  graphics window. 

1 Right click over the component or sub-assembly you wish to 
copy. Select Copy from the pop up menu. The component or sub-
assembly will be highlighted. 

2 Right click and select Paste. A copy of the component or sub-
assembly will be added to the model. 

You can also make a copy of a component or sub-assembly by 
selecting the component and using the Edit menu on the toolbar. 

 

Grouping and ungrouping assembly components 
You can add an assembly component to a Group and remove an 
assembly component from a Group using options on the context 
menu in the assembly tree and the graphics window. 
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Using the assembly tree menu 
When you right click on an assembly component in the assembly 
tree, the following context menu is displayed. 

 
Add - Choosing this option will display the Select Group dialog. 

Remove  - Choosing  this option will remove the selected component 
from the group. This option is only active if the selected component 
has been previously added to a group. 

 

Select Group dialog 

 
1 Select an existing Group name from the drop down list. 

2 Click OK. The selected component will be added to Group you 
selected. 

A new item will be added to the assembly tree. 

 
You can also enter a new Group name. If this name is not unique 
within the assembly, the name will be automatically made 
unique. 

 

Ungrouping a Group 
You can ungroup a Group as follows: 
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1 In the assembly tree, right click  the group to display the context 
menu. 

 
2 Select Group 

3 Select Remove. All components are ungrouped from the Group 
and the Group is removed from the assembly tree. 

 

Renaming a Group 
1 Select the appropriate Group with the right mouse button to 

display the Group popup 

2 Select Rename from the options on the popup 

3 Enter the new name and click OK. 
 

Converting a sub-assembly into a Group 
You can convert a sub-assembly into a Group using the assembly 
tree context menu. 

 

Converting a Group into a sub-assembly 
You can convert a Group into a sub-assembly using the assembly 
tree context menu. 

 

Components 
Creating components using the toolbar or menu 

1 Ensure that you have a model displayed. 

2 Select Assembly  from the main toolbar. The Assembly 
modelling toolbar will be displayed. 

3 Select one of the following from the Create from solids  flyout 
or Add component  flyout  
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 - Add a component from selected solids (see page 86) (Create 
from solids flyout) 

 - Creating components from selected solids with Power 
Features (see page 87) (Create from solids flyout).  

 - Adding a component using the Intelligent Cursor (Add 
component flyout) 

 - Adding a component with advanced options (see page 90) 
(Add component flyout) 

You can also create components using the Component options of the 
Object menu. 

 
 

Creating components from selected solids 
You can create components in the active assembly from selected 
solids and registers their component definitions in one step. 

1 Click  to display the Assembly modelling toolbar. 

2 Make sure you have an active assembly. 

3 Select some solids. 

4 Click  (Component from solid flyout). 

The selected solids become components and remain in their 
original positions. Component definitions are automatically 
created for the components. The names of the components and 
their definitions are the same as their original solid. 
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Creating components from selected solids with Power 
Features 

This lets you define a new component from selected solids with 
Power Features. This is the same as the option Add to assembly with 
Power Features that is available from the solids context menu. 

1 Click  to display the Assembly modelling toolbar. 

2 Make sure you have an active assembly. 

3 Select some solids with Power Features. 

4 Click (Component from solid flyout). 

The selected solids become components and remain in their original 
positions. Component definitions are automatically created for the 
components. The names of the components and their definitions are 
the same as their original solid. 

 

Adding components 
You can add components using the Intelligent Cursor. 

1 Click  to display the Assembly modelling toolbar. 

2 Click  (Add component flyout). The Add Component dialog is 
displayed. 

3 Use the Add Component dialog (see page 88) to select a 
component to add to the model.  

4 Click Apply. The component is attached to the cursor. You can 
position the component and it is automatically aligned to the 
geometry beneath the cursor. 
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Add Component dialog 
Use this dialog to add the selected component to the assembly. The 
tree in the left-hand pane of the dialog box reflects the assembly 
models you have open and the current working model. 

 
Use the tree to select a component or assembly from the current 
model. 

Browse — Use this button to locate components to add to the 
model. These components must be in inactive unopened models. 

Name filter — Enter a string to filter the list of models that appears 
in the Inside Database and Outside database folders.  

To display models that have a name starting with SHOE: 

1 Ensure that Inside Database and Outside Database are expanded 

2 Enter SHOE* in Model name filter. 
3 Press Enter. 

Category name filter — You can use this drop down list to filter 
component definitions by category name. The drop down box 
contains all the category names found in the active model. 
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When you have selected a category name, the tree browser will 
show only those definitions where the category name matches the 
selected filter. 

Break link with original component — Use this option to retain or 
break  the link with the original component definition when you add 
a component from the Component Library or another model. 

If deselected, the component definition is added to the assembly 
tree, but a copy of the component definition is not stored with the 
assembly. The 'linked' component definition is indicated by the  in 
the assembly tree.  

If selected, a copy of the component definition is created and stored 
with the assembly. The local component definition is indicated by 
the standard component definition  icon in the assembly tree and 
it can then be used in the same way as any other component 
definition. If the component definition is modified in the originating 
assembly or in the Component Library, use the Refresh imported 

component definitions  button to update the component 
definition in the current assembly. 

 When the dialog is displayed, the initial status of this option is 
controlled by the Create local copy of component definition on 
the General page of Assembly options. If you change the 
status of the option within the Add Component dialog, the new 
status only applies for the component you are currently 
adding. 

Create in the original position — If this option is selected, the 
component is located into the position where the geometry was 
registered. The option is only active when you add a component 

using Add component on Intelligent Cursor  button. 

 Create in the original position is useful for component 
positioning in a multi-model assembly. If the option is 
selected, the new component is inserted in the same position 
as in its original model. 

Apply — Adds the component to the assembly. The component is 
added outside the bounding box of the existing components in the 
assembly. If the component is the first one added to the assembly, 
it is in the same position as its original solid. 

If you are adding a parameterised componen (see page 118)t to the 
assembly, the Parameter List Editor dialog will be displayed. You can 
use this to edit the values of the parameters. The dialog remains on 
the screen, so that you can add more components. 
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OK — Removes the dialog from the screen. 

 If you click Undo  after adding components using the Add 
component dialog, all the components that you added using 
the dialog will be deleted. 

 

Adding a component with advanced options 
1 Click  to display the Assembly modelling toolbar. 

2 Click  (Add component flyout). The Add Component dialog is 
displayed. 

3 Use the Add Component dialog (see page 88) to select a 
component to add to the model. The component to be added to 
the assembly must have an axial attachment. 

 

Adding a component using the assembly tree or 
component library 

You can add an existing component to an assembly using the 
assembly tree or the component library 

1 Double click on a component icon in the assembly tree or the 
thumbnail in the component library 

2 The cursor will change shape  and the component graphics will 
appear on the edge of the model window nearest to the cursor. 
Position the components using the cursor.  

 

Creating components using the assembly tree 
You can create a component from a solid using the assembly tree. 

1 Right click the solid in the assembly tree. 

2 Select Add to Assembly from the context menu. 

If an assembly does not already exist, it is created automatically 
when you select Add to Assembly from the context menu or 
Create compoents from selected solids  (Add components flyout) 
The new assembly is created with default name 
NNNNNN_assembly  
 
where NNNNNN is the name of model.   
 
For example, NEW_MODEL_1_11_assembly is the name of the 
assembly that is created from the model called 
NEW_MODEL_1_11 
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Adding relationships between components 
You can add relationships to components using the Create Relations 
dialog. 

1 Make sure you have at least two components on the screen. 

2 Click  to display the Assembly modelling toolbar. 

3 Click Add relation using attachments  on the Relations flyout to 
display the Create Relations dialog. 

4 Use the Create Relations dialog (see page 91) to create 
relationships between two components in the assembly. The new 
relationship is added to the assembly tree. For further details, 
see What is the assembly tree? (see page 9) 

 

Creating relations using attachments 
Use the Create Relations dialog to create relations between 
components. Create Relations replaces the Relations toolbar. 

1 Click  from the Relations flyout on the Assembly toolbar. 

The Create Relation dialog is displayed. 
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The following simple example illustrates the options on the 
dialog: 

 

2 Select the first attachment . This is the master attachment.The 
cross  icon changes to a tick  icon.. 

3 Select the second attachment . This is the slave attachment. 
The model and the dialog are updated as follows: 

 A Coincident Plane to Plane relation is created between the two 
components. Selected Plane to Plane relation is displayed in 
the dialog and  is displayed as the Relation type. 

 The slave component  is rotated to reflect the relationship 
you have defined. 

 The information panel is updated to indicate if there is a 
conflict. 

4 Enter a Distance of 100 or click  and use the slider in the 
Angle/Distance Scaler dialog (see page 97) to specify the 
distance. The model will be updated. 
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5 Click  to display Relation type options. 

6 Select  to change the Relation type to Angular. 
7 Enter 25 as the Angle. 

 

8 Click  to Anti-align (see page 97) so that the slave attachment 
lies in the opposite direction to the master attachment. 

9 Click Apply to create the relation you have just defined. The 
dialog is still displayed to allow you to specify additional relations 
in a more complicated model. 

10 Click OK to finish creating relations. The relationship that you 
have created is added to the assembly tree. 

 

 Relations are added to the tree when the second attachment 
is selected. If you realise you have made an incorrect 
selection before you click Apply, do one of the following: 

 Close the dialog, delete the relation from the assembly tree 
and then create the relation using the correct selection. 

 With the dialog still displayed, use Select first attachment and 
Select second attachment to modify the relation. 

 

Selecting a Relation type 
The Relation type determines the relationship between the 
attachments on the two components in the assembly. 
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There are three options: 

 Coincident  

 Angular/Parallel  

 Perpendicular  

In the 2D example below, 

 is the master component 

 is the slave component. 

 shows the selected plane attachments. 

 
The slave component is positioned using the attachment of the 
master component. 

In the example, the master has a plane attachment. The plane of 
the attachment is used to position the slave component. The line 
representing the plane is indicated by  

 

Coincident  - The slave is positioned so that its attachment is 
coincident with the attachment of the master. 
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In the example, the slave is positioned so that its plane attachment 
lies in the same plane as that of the master. 

 
You can position the slave such that its attachment is at a distance 
from the attachment of the master. Enter a Distance or use the 
Angle/distance scaler (see page 97) to define a distance. 

In the example, the slave is positioned so that its plane attachment 
is at a distance from the plane attachment of the master. The 
distance is indicated by . 

 

Angular/Parallel  - The slave is positioned such that its attachment 
is at an angle to the attachment of the master. If the angle is 0, the 
slave is positioned so that its attachment is parallel to the 
attachment of the master. Enter an Angle or use the Angle/distance 
scaler (see page 97) to define an angle. 
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In the example, the slave is positioned so that its plane attachment 
is parallel to the plane attachment of the master. The position of the 
two parallel planes is indicated by .  

Angular/Parallel relation type may be set for the following types of 
relations: 

 plane to plane 

 plane to line 

 line to plane 

 line to line 

The actual distance between the planes is undefined at this stage 
and needs to be defined by another relation type. 

 

Perpendicular  - The slave is positioned such that its attachment 
is perpendicular to the attachment of the master. 

In the example, the slave is positioned so that its plane attachment 
is perpendicular to the plane attachment of the master. 
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Angle/distance scaler 
Use the  Angular/Distance Scaler dialog  to dynamically change the 
angle or distance of the relationship between the two components. 

 
Adjust the following to change the angle or distance between the 
two components: 

 Move the slider to change the angle or distance between the two 
components. The scale on the slider increases or decreases using 
the value in the Increment box.  

 Enter a different Increment value to change the increment of the 
scale. 

 Enter alternative Maximum and Minimum values for the slider. 
 

Orientation 
This determines how the two attachments are aligned. There are 
two options: 

 Align  - The attachment of the slave lies in the same direction 
as the master's. 
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 Anti-align  - The attachment of the slave lies in the opposite 
direction as the master's. 

 
 

Managing attachments 
Use the Manage Attachments dialog to: 

 edit existing attachments. 

 create new attachments. 

With a component selected, click  from the Relation flyout on the 
Assembly toolbar. Alternatively, select Manage Attachments from the 
component context menus. 
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The Manage Attachments dialog is displayed. 

 

Editing existing attachments 
Edit is selected by default. This lets you: 

 rename an attachment by selecting the existing name from the 
drop-down list and enter the new name. 

 set the selected attachment as the Default attachment. 

Creating attachments 
Use the Manage Attachments dialog to create attachments in one of 
the following ways: 

 Creating an attachment in space is useful when you are trying to 
position a component and there is no other geometry to attach 
to.  

Click Create in space and click the required position. The 
attachment is created at the specified position. The attachment 
position will not update if the component geometry is modified.  

 Creating an attachment on surface is useful when you are trying 
to position a component and a default attachment of plane, point 
or line isn't available. Create on surface lets you attach to a 
specified position. 

To create an attachment on a surface, click Create on surface and 
click anywhere on the surface. The attachment is linked to the 
underlying surface parameters and will update if the geometry is 
modified. 

When you have created the attachment, the Edit option is selected 
on the dialog. Use the following options to modify the attachment: 

 By default, the new attachment is named Unnamed. Enter a new 
name as required. 
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 Edit the X, Y and Z coordinates or click  to enter the 
coordinated using the Position dialog. 

 Click  to remove the attachment that you have just created. 

 Click Default attachment to make the new attachment the default. 
 

Displaying the attachment points 
Add relationships to components by dragging the components. The 
attachment points are displayed by moving the mouse over the 
model as follows: 

1 Select the component you want to be slave component 

2 Move the mouse over the component to highlight the plane/axis 
attachments.  

 
3 To use a point attachment, click the component again and move 

the mouse over the component to highlight the point 
attachments.  

 
 

Adding relationships using drag and drop 
Add relationships to components by dragging the components and 
using the attachment points to create a relationship between two 
components.  



 

PowerSHAPE 2015 R2 Reference Help Assembly modelling • 101  

The example below uses plane/axis attachments. The face is 
coloured blue and a large yellow arrow indicates the attachment. 

 
1 Drag this attachment towards another component. This shows 

the attachment on the second component (master component) 

 
The face is coloured blue and a large yellow arrow indicates the 
attachment. This confirms the correct attachment is under the 
cursor. 

2 Release the first attachment onto an attachment on the second 
component. 

 
The first component is now related to the second component. If 
you release the mouse away from the second object, no 
relationship is created and the slave component will return to its 
original orientation. 

The new relationship is added to the assembly tree.  

For further details, see What is the assembly tree? (see page 9) 
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Displaying the properties of a component in the model 
To display the properties of a component in your model, 

1 Select View > Windows > Component Library to display the 
Component Library for your model. 

2 Right click the component in the Component Library to display 
the Component popup. 

3 Select Modify - Properties from the component popup. 

4 Ensure that you have at least one property defined for the 
component. 

5 Click on the text creation  flyout and select the direction of the 
text. The properties of the component are attached to the cursor. 
The format of the text is defined on the  Options - Assembly - 
General dialog. 

6 Click near the component to display the text at that location. 
 

Inserting axial components into holes 
Use this option to insert axial components into holes. Axial 
components are ones such as ejector pins, bolts and screws. The 
command looks for plane and axis attachments on the new 
component. Typically, this would be the centre of a screw head or 
ejector pin. 

A slave component is inserted onto a master component using plane 
and axis attachments on the components. 

1 Make sure you have at least one component on the screen. The 
following component will be used to demonstrate how to insert 
axial components. 

 

2 Click  to display the Assembly modelling toolbar. 

3 Click  (Add component flyout). The Add Component dialog is 
displayed. 

4 Use the Add Component dialog (see page 88) to select a 
component to add to the model. The component to be added to 
the assembly must have an axial attachment. 
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The selected component is added outside the bounding box of 
the existing components in the assembly. The component is 
added as a slave and is coloured green (using the default colour 
scheme). The Insert axial component toolbar (see page 105) is 
displayed. 

5 Select the component  as the slave. 

 
You can change the slave component if you want. To do this, 

click  on the Insert axial component toolbar to display the Add 
Component dialog. Use the dialog to select another component. 

6 Select an existing component  as a master. 

 
You can change the master component if you want. To do this, 

click  on the Insert axial component toolbar and then select 
another component. 

7 Hover the mouse over the slave component to see its valid 
attachments such as  below. 

 
Only combined attachments are visible. These are attachments 
where plane and axis attachments meet. 
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8 Click the attachment  on the slave component. 

 

To change selected slave attachment, click  on the Insert axial 
component toolbar and then select another attachment on the 
slave. 

9 Use the Distance box to set a distance between the master and 
the slave components. 

10 Use  or  to reverse the current alignment of the attachment 
on the slave component with the master component. 

11 Hover the mouse over the master component to see the valid 
attachments. 

 
By default, two types of attachments are visible:  
 plane  
 combined. Combined attachments are usually where holes 

exist in the master component. 

You can use  on the Insert axial component toolbar to only 
highlight the selected type of attachment on the master 
component. This menu contains the following options. 

 Highlight either combined or plane attachments 

 Only highlight combined attachments 

 Only highlight plane attachments 
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12 To add the slave component, click an attachment on the master 
component. The technique you use is slightly different depending 
on whether you click a plane attachment (see page 105) or a 
combined attachment (see page 106). 

To change selected master attachment,, click  on the Insert 
axial component toolbar and then select another attachment on 
the master. 

13 To exit insert axial component mode, click Select . 
 

Insert axial component toolbar 
You can use this toolbar to change your component and attachment 
selections while you insert axial components. 

 
 The toolbar will automatically select its tools from left to right. As 

you select the required objects, the next tool is automatically 
clicked, ready for you to make the next selection.  

 You do not  need to select buttons on the toolbar unless you 
want to change any of its options.  

 If you change any option, the toolbar continues from that option. 
 

Plane attachment 
1 Click a plane attachment to select the plane in which the slave 

component will be attached. 
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2 Click a position on the plane to position the slave component. 

 
This creates a plane to plane relationship between the slave 
component and the master component. 

 

Combined attachment 
1 Click a combined attachment on the master component to fix the 

slave component onto attachment. 

 
The slave component will have a line-to-line and a plane-to plane 
relationship with the master component. 

 

Editing relationships using the Relation context menu 
Use the Relation context menu to edit or delete relationships. 

In the assembly tree, right click one of the following to display the 
Relation context menu. 
 Master Relations 
 Slave Relations 

 the relation (for example, Coincident, Perpendicular) 
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The options displayed on the context menu reflect the item you 
select. 

 
The Relation popup will display a combination of the following 
options: 

 Create - Select this option to display the Create relations dialog 
(see page 91). 

 Delete - This deletes the relationship. 

 Selection Information - This displays the Selection Information 
dialog that gives details of the selcted objects and relationships. 

 Edit - This displays the Relationships toolbar. You can use this to 
edit the master and slave relationships. 

 Suppressed - If selected, this removes the relation between the 
two components. 
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 appears next to the relation to indicate that it is suppressed.  
is also placed next to its corresponding relation. 

 
To add the relation back again, right click the relation again in 
the assembly tree and select Suppressed from the pop up menu. 

 Explode and Inverse Explode let you include or omit the current 
relation from an explode operation and switch direction of 
exploding. 

 
The model below can be used to show how these options work. 

 
Explode - Switches the simulation functionality ON and OFF. 

1 Select Explode from the Relation popup.  

2 Select  (assembly toolbar) to display the Explode toolbar.  
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3 Select  from the Explode toolbar, to run the explode 
operation.  

 
Inverse Explode - Inverse Explode is only available when Explode 
is ON. If Inverse Explode is set to ON, the component will explode 
in the opposite direction to the default. 

1 Select Explode and Inverse Explode from the Relation popup.  

2 Select  (assembly toolbar) to display the Explode toolbar.  

3 Select  from the Explode toolbar, to run the explode 
operation.  

 
 

Editing a component in the assembly 
You can modify the geometry of a component using standard 
modelling commands. 
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1 Right click the component either in the graphics window or the 
assembly tree and select Modify from the pop up menu to display 
the options. 

2 Select Geometry from the Modify options. The component is 
converted back into a solid and you are in modelling mode, ready 
to modify the component. 

The Modify toolbar is displayed. 

 
3 Modify the solid as appropriate. When you modify all instances of 

a component, you will only see the changes in the current 
component.  

4 Click  to preview the changes in all instances. 

If you don't want to store the modified solid as a component, 

click  on the Modify toolbar. 

5 Once you have finished modifying the solid, click  on the 
Modify toolbar. 

The solid converts back into a component. 

 1 - When you Modify a component, you can add or remove a 
Main Solid or a Power Feature Solid using the context menu of 
the solid in either the graphics window or the assembly tree. 
2 - If the component you are editing is parameterised, you 
can change the value of any parameter that is independent. 
For further details, see How do I edit a parameterised 
component? (see page 119). 

 

Repositioning a component 
You can reposition any component in an active assembly in one of 
the following ways: 

 Selecting the attachment of a component and moving the 
component. 

 Right click the component and select Position from the Modify 
options on the pop up menu. Use the Component Position dialog 
(see page 111) to reposition the component. 

 Double click the component. Use the Component Position dialog 
(see page 111) to reposition the component. 
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 Right-click the component in the assembly tree and select 
Position from the Modify options on the pop up menu. Use the 
Component Position dialog (see page 111) to reposition the 
component. 

 The 'drag and drop' technique can be used to reposition a 
component. 

1 Move the cursor over the component to highlight an 
attachment 

2 Drag the component to the required position.  

As you move over the model, the component will align itself to 
other geometry it is dragged over. Dropping the component on 
another component will automatically create a relation. 

 You can use Quick rotate (hold down R and rotate the cursor 
wheel) whilst dragging a component. The component will revolve 
around the attachment axis. 

 

Component Position dialog 
Use this to move a component within an assembly. 

 
Select an attachment - To reposition a component relative to one of 
its attachments, select this option and then select an attachment on 
the component. 

The selected attachment will be used as an origin for repositioning. 
The  changes to  to indicate an attachment is selected. 

Position - Select this option to edit the position. 

Relation - This menu is only available if all of the following 
conditions are true: 

 No attachment is selected. 

 The component is a slave. 

 The component has either planar-to-planar or planar-to-point 
relationships, where the planar attachment is on a master 
component. These relationships appear in the Relation menu. 
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When you select a relationship, the attachments on the component 
and its master component become highlighted. 

You can use this dialog to reposition the slave component on the 
planar attachment of the master component. 

Workspace - Select a workspace. 

 Relative - (Only available if a relation is selected). The co-
ordinates are measured from the origin of the plane. This origin 
is marked as shown below. 

 
 World - The coordinates are measured relative to the world 

workspace. 

 Workplane - The coordinates are measured from the origin of the 
active workplane. 

Position - Enter new coordinates using one of the following 
methods: 

 Click a new position on the model. 

 Enter new XYZ coordinates directly in the dialog. 

 Click  to display the Position dialog to use position entry tools. 

Apply - Apply the changes. The dialog will still be displayed, so you 
can reposition another component. 

OK - Accepts the position and closes the dialog. If any relation 
conflicts with the new position, it will be deleted. 

Cancel - Cancels the changes and closes the dialog. 
 

Grouping components 
When you right click an assembly component in the graphics 
window, the following context menu is displayed. 
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Add  - Select this option to add one or more selected components to 
a Group, using the Select Grouped Sub-assembly dialog. 

 
Select an existing Group name from the drop down list and click OK. 
The component will be added to Group you selected. 

A new item will be added to the assembly tree. 

 
You can also enter a new Group name. If this name is not unique 
within the assembly, the name will be automatically made unique. 

Remove  - Select this option to remove the selected component 
from the Group. This option is only active if the selected component 
has been previously added to a Group. 

 

How do I find out if components intersect? 
You can check whether components intersection in an assembly. 

1 Select the components. 
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2 Click  to display the Assembly modelling toolbar. 

3 Click  (assembly modelling toolbar). The Analysis of 
intersection dialog is displayed. 

 
This dialog reports any collisions between the selected 
components. 

4 If you want to check other components, select them and click 
Update. 

5 Click OK to remove the dialog from the screen. 
 

Converting a component into a solid 
You can convert a component into a solid using the context menu  

1 Right click the component you wish to convert, either in the 
assembly tree or in the graphic window 

2 Select Convert from the context menu. 

3 Select To Geometry from the options. Any relationships created 
using the component will be deleted. 

You can also convert a component into a solid using the Edit menu: 

1 Select the component. 

2 Select the Edit menu, followed by Convert and then Component. 
 

Converting a sub-assembly into its components 
You can convert a sub-assembly into its components, whilst keeping 
the relationships between the components in the sub-assembly. 

1 Right click the sub-assembly in the assembly tree. 

2 Select Convert from the context menu. 

3 Select To Components from the options 



 

PowerSHAPE 2015 R2 Reference Help Assembly modelling • 115  

You can also convert a sub-assembly into its components using the 
Edit menu: 

1 Select the sub-assembly. 

2 Select the Edit menu, followed by Convert and then 
SubAssembly. 

 

Setting the material on a single component 
You can set the material and style of a single component or a single 
component in a Group, using the Assembly Tree. 

1 In the assembly tree, right click a single component or a single 
component in a Group. 

2 Select one of the following options from the context menu. 

 
Use Style from Sub-items - If ON, the component uses the style 
attributes of sub-items. If OFF, it uses the creation style of the 
component. 

Use Material from Sub-items - If ON, the component uses the 
material attributes of the sub-items. If OFF, it uses the creation 
material of the component. 

So, if you reset the material on a component, it uses the same 
material as the component definition. If you reset the material 
on a sub-assembly, its components will use their own materials. 

You can also set the material on multiple components (see page 
116) using the popup in the assembly tree. 

For further details, see What is material? in the Delcam Render 
manual. 
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Setting the material on multiple components 
You can set the material and style of  a selection containing more 
than one component using the options on the context menu in the 
assembly tree. These options allow you to set or reset the style and 
material for many components in a single operation. 

The selection can be a 

 Group 

 Multiple selection of components 

 Multiple selection of Groups. 

 
Use Style from Sub-items - The selection uses the style attributes of 
sub-items. 

Use Own Style - The selection uses the creation styles of the 
selection. 

Use Material from Sub-items - The selection uses the material 
attributes of the selection. 

Use Own Material - The selection uses the creation material of the 
selections. 

 

Renaming an attachment 
You can give a name to a selected attachment. This can be useful 
for automation, when writing macros or Visual Basic. 

1 Right click the component in the graphics window and select 
Manage Attachment to display the Manage Attachment dialog (see 
page 98). 

2 Select the attachment from the dropdown list. 

3 Enter the name for the attachment in the text box and click OK 
to remove the dialog from the screen. 
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Parameterised Components 
Introduction 

You can create a parameterised component from a solid that has 
dimensions defined by parameters. This allows you to create 
components with different dimensions from the same solid. 

 

Assembly Parameters 
Parameters can be shared between solids when they are added to 
an assembly. 

To see how local and shared parameters work within an assembly, 
work though the following steps: 

1 Create a block with height h=100 

2 Create a cylinder with height h. 

3 Select the block and click Create components from selected solids 
. 

4 Select the cylinder and click Create components from selected 
solids . 

 It is important to add the block and the cylinder using 
separate operations. 

5 Modify the height of the block component. The height of the 
cylinder component should remain unchanged. 

This is because, by default, components have local parameters. 
Although both solids were defined using the parameter h, once 
they are added to the assembly as components, the parameters 
are independent and  h can have different values. This is useful 
because assemblies often have multiple instances of the same 
object.  For example, you would not necessarily want all the 
screws to have the same length. 

6 Create a block with height h=100  

7 Create a cylinder with height h 

8 Select both block and cylinder and click the Create components 
from selected solids .  
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In this case, the parameter h that is shared in the solids will also 
be shared in the assembly. The assembly tree shows that  the 
block, cylinder and assembly are parametric.  

 
You can modify the shared parameter by right clicking on the 
assembly icon in the tree and selecting Modify Parameters. If you 
change the value of h in the Parameter List Editor for Assembly 
dialog, the value will be applied to both the cylinder and block 
components. 

 
 

Adding a parameterised component to an assembly 
You can add a parameterised component to an assembly as follows: 

1 Create a parameterised solid 

2 Right click the solid to display the solid context menu. 

3 Select Add to Assembly from the context menu. The 
parameterised solid is converted to an component and added to 
the assembly. 

The  icon in the assembly tree indicates that a parameterised 
component has been used. 
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Modifying parameters 
Changing the parameters for each component 
 You can have many components in an assembly that are based 

on a single component definition, but with different values for 
their independent parameters. 

 When you change the value of a parameter of a component, it 
preserves any relationships with other components. 

 You can change the value of any independent parameter. If this 
parameter is used by another parameter in that component, the 
dependent parameter will also be updated. The dependent 
parameter is not displayed in the Parameter List Editor dialog 
(see page 121). 

Modify parameters with the same name on multiple toolmaker 
components  
 Components with the same name that are from the same catalog 

are modified using the Component Wizard. This lets you apply 
the same parameter values to the selected components. 

 If selected components are mix of Toolmaker components and 
general components, the Parameter List Editor dialog is 
displayed. Enter a new value to modify a parameter. 

 If all selected components are Toolmaker components, but are 
from different catalogs or have different names, the Parameter 
List Editor dialog is displayed. Enter a new value to modify a 
parameter. 

 

Editing a parameterised component 
1 Right click the component in the browser tree.  

2 Choose one of the following options to display the Parameters 
List Editor dialog (see page 121). 

 Select Parameter from the Modify options of the component 
context menu. This modifies the parameters of parameterised 
component that are selected in the assembly tree. 

 Double-click on a parameterised component in the model. 

 Select Modify Parameters from the All Instances options of the 
component context menu. This modifies the parameters of 
components based on the same definition that use exactly the 
same parameter values. 
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The following example shows how this option can be used. All 
the components were created with the same radius, but the 
middle one has a different height. 

 
If we change the height of the component on the left using 
the All Instances option, the two identical components change 
shape. 

 
If you change the height of the middle to match the other 
two, all three components will become identical. 

 
So if you edit any parameter on one of the three objects using 
the All Instances option, all three will change shape. 

 
3 Use the Parameter List Editor dialog (see page 121) to change 

the value of the parameters. 

You can also use this dialog to change the dimensions of the 
component as you add it to the assembly. For further details, see 
Adding a parameterised component to an assembly (see page 
118) 
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 (1)  The parameters used by objects that do not belong to the 
parent assembly cannot be used as parameters of a 
parameterised component. These parameters are hidden 
when the Parameter List Editor is displayed. 
 
(2)  When a parameter is applied to parameterised 
component value, the current assembly becomes 
parameterised. A parameterised assembly is marked by  in 
the tree browser. 

 

Parameter List Editor dialog 
Use this dialog to modify parameters on components, assemblies 
and definitions. 

 
This dialog displays the current values of the parameter used in the 
component. You can change the parameter by clicking the existing 
value and entering the new value. Display the calculator by right 
clicking the value. 

Apply - Updates the value of any parameter that is dependent on 
the edited parameter. 

OK - The assembly is updated and the dialog is removed from the 
screen. 

 

Using parameters in a relationship 
Define the Angle/Distance value of the selected relation using 
parameters in one of the following ways: 
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 Typing an expression into the Distance/Angle box on the 
Relationship toolbar. 

 Right clicking on the Distance/Angle text box to raise the 
calculator. You can enter an expression or a value in the 
calculator. When you press Accept on the calculator, the value 
(or the value of the expression) will be shown in the 
Distance/Angle text box. 

Parameterised relations are marked by  in the tree browser. 

When a parameter is applied to a relation, the current assembly 
becomes parameterised. 

A parameterised assembly is marked by  in the tree browser. 
 

Editing a parameterised assembly 
You can modify the parameters used in relations and parameterised 
components in an assembly. 

To edit the parameters used in an assembly 
1 Right click the assembly in the browser tree to display the 

assembly context menu. 

 
2 Choose Modify Parameters to display the Parameter List Editor 

dialog (see page 121) 

3 Click on Apply. The updated assembly will be displayed. 

4 Click on OK to remove the dialog from the screen. 
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Exploding assemblies 
Examining an assembly 

The Explode toolbar lets you create an exploded view of an 
assembly to show how it is put together. 

 
You can explode an assembly using the distance or angle parameter 
from the relationships of the components. 

1 Make sure you have an active assembly. Some of its components 
must contain either a distance or angle relation. 

2 Click Explode  to display the flyout. 

3 Select one of the two options to create an exploded view of the 
active assembly: 

 Explode the assembly using a distance parameter. The view 
will be exploded along the axis in which the distance was defined 
when creating the relationship between the components. 

 Explode the assembly using an angle parameter. The view will 
be exploded around the axis in which the angle was defined 
when creating the relationship between the components. 

4 Select the options on the Explode toolbar (see page 123). 
 

Explode toolbar 
This toolbar is displayed when an option is selected from the 
Explode  flyout. 

 
The items on the toolbar are grouped as follows: 

The following let you enter parameters for the explode operation: 

Distance - Enter a distance of exploding of the active assembly, 
or select a previously used distance from the pull down list. 
(Note - This option is only available if you are exploding the 
assembly using a distance parameter.) 
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Angle – Enter an angle of exploding for the active assembly, or 
select a previously used angle from the pull down list. (Note - 
This option is only available if you are exploding the assembly 
using an angle parameter.) 

Number of steps - Enter the number of steps for exploding, or 
select a previously used number from the drop down list. 

Step time - Enter a time between steps during exploding, or 
select a previously used time from the drop down list. 

The following buttons that let you control the explode operation: 

 If this is ON , the assembly will be exploded and re-
assembled in a continuous loop. To exit from the cycle, click the 

 button on the processing bar. 

 Start exploding the active assembly. 

 Previous step of the exploding operation. 

 Next step of the exploding operation. 

 Stop the exploding operation. The original, unexploded 
assembly will be displayed. 

 Abandon exploding and exit. 
 

Schedules 
Creating a schedule for components and assemblies (see page 124) 

Creating hole schedules for assemblies (see page 125) 
 

Creating a schedule for components and assemblies 
You can create schedules from assemblies. A schedule for an 
assembly is a bill of material. This is a table of components/sub-
assemblies used by an assembly. 

You can also create schedules from components. Since components 
are part of an assembly, a schedule from components is similar to 
the one for assemblies. 

For further details, see What is a schedule? in Delcam Draft.. 
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Creating hole schedules for assemblies 
You can automatically create detail drawings of hole schedules from 
an assembly. You can create hole schedules for a mold base design 
like the one below.  

 
1 Select Component Drawings from the Tools menu. The 

Component Drawing dialog is displayed. 

2 Set the options in the dialog as required 

3 Click OK 

A drawing is created for each plate in the assembly and contains the 
following: 

 Two views of the plate: top and side 

 Dimensions of the plate (for molds only) 

 A hole schedule and labels 
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You can customise the drawings using the template model called 
component_drawing_template.psmodel. 

 

Change the template for the drawings 
The drawings are created from template drawing in the 
component_drawing_template model in the dcam/parts folder. The 
template drawing is called component_drawing_template. 

You can modify the template drawing to your own requirements. 

During installation, the component_drawing_template model is put 
in the following folder: 
C:/dcam/product/powershape152XX/file/assembly 

When you create hole schedules for an assembly for the first time, a 
copy of this model is automatically imported into the dcam/parts 
folder. 

 

Using the Component Wizard 
For information on adding components using the Component 
Wizard, see: 

Adding components to an assembly (see page 126) 

Selecting a component (see page 126) 

Defining a component using the Component Wizard dialog (see page 
128) 

Component Colour scheme (see page 137) 
 

Adding components to an assembly 
You can add components from standard catalogs to your assembly. 

Product specific catalogs are supported, so different component 
libraries are available with, for example, Delcam Designer, Delcam 
Toolmaker and Delcam Crispin SoleDesign. 
To create a component in the assembly, 
1 Select a component from the catalog (see page 126). 

2 Define the dimensions and material of the component (see page 
128). 

 

Selecting a component 
A component is selected from the catalog as follows: 
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1 Click  (Assembly toolbar) to display the Choose a component 
dialog 

 
2 Use the options to select a component. 

Tree view options — Controls the way that the catalogs are 
displayed in the tree. 

 Component code name first — If selected, the components are 
listed using their catalog part numbers. 

 Group catalogs by family — If deselected, the catalogs for an 
individual manufacturer are listed separately. If selected, 
catalogs are grouped by manufacturer. So, 
DME-North America 
DME Europe 
DME Europe (DME Standard) 
DME Europe (Euro Standard) 
will all appear under DME in the tree. 

Manage custom catalogs — Use the options in this section to 
create, edit and structure catalogs. Details and examples of this 
functionality are included in the Custom catalogs dection of the 
Delcam Toolmaker manual. 
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 — This gives the list of components in the catalog. 
Select a component to create from this list. When you select a 
component from a catalog, the image of the component is 
displayed in the dialog.  

 
The image shows the dimensions you can set on the selected 
component. For certain components, there are tabs over the 
image. Selecting a different tab lets you see different images for 
these components. This makes it easier for you to see all the 
parameters of complex components. 

OK — Selects the component and opens the page for that 
component in the browser window. This page is used to define 
the dimensions of the component (see page 128). Each 
component will have its own page in the browser window.  

Cancel — Removes the dialog from the screen. 
 

Defining a component using the Component Wizard 
dialog 

Use the Component Wizard dialog to: 

 Edit the size of a component.  

1 Select Modify Parameters from the Component context menu 
to display the Component Wizard dialog.  

2 Edit the component and select Apply. The model will be 
updated. 

 Set the dimensions and material of the component.  
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1 Select dimensions and material values from the catalog.  

2 Enter your own values, as required, to create user-defined 
components. These can still have some of the properties of a 
standard component. However, user-defined components 
have to be manufactured, whereas standard components can 
be ordered from a catalog supplier. 

 You can also display the Choose a component dialog as 
follows: 

1. Click on the Component wizard dialog to ensure that it is 
active 

2. Hold down the Alt key and press C 

There are four types of tab that are displayed in the dialog 

 Component Wizard - Standard tab (see page 130) 

 Component Wizard - Custom tab (see page 133) 

 Component Wizard - Key & Trim tab (see page 135) 

 Component Wizard - Clearances tab (see page 136) 
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Component Wizard - Standard tab 
The Standard tab displays the dimensions for the catalog component 
that you have selected. 
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The exact parameters that are displayed reflect the type of 
component you are defining. When the program is run on a low 
resolution screen, the levels toolbar is automatically switched off 
and height of the panel is limited to leave more space for the 
component parameter controls. 

The image in the graphic window is the component you selected 
using the Choose a component dialog. The image shows the labels 
of the dimensions on the selected component. 

For certain components, there are additional tabs on the dialog. 
These tabs correspond to the tabs displayed in the Choose a 
component dialog. Selecting a different tab lets you see different 
images for these components. This makes it easier for you to see all 
the parameters of complex components. The different images are 
displayed by selecting a tab on the wizard. 

 
The default dimension and material options for the component that 
you have selected from the catalog are displayed in this section of 
the dialog. To see all the catalog options for the component, click 

Show All . Select the dimensions and material you require. 
Options to customise settings are available on the Custom tab (see 
page 133). 

As you select a dimension from one column, the numbers of the 
other columns reduce to show valid combinations only.  

Material - Select the International Standard number for the material 
to be used. 
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Click on the coloured bar to reveal the fields. 

 
To hide the fields, click the coloured bar again. 

Function - The option you select specifies which component you 
intend to position the component on. Either select an option from 
the drop down list or use the default option (Selected on model) to 
pick the component in the model. 

Position the component - If this option is selected and you click 
Apply on the browser page, the object is added to the assembly. 
You can then position it using the following technique from 
Assembly modelling. 

1 Select an existing component. Valid attachments are now visible 
on the new component. 

2 Click an attachment on the new component. Valid attachments 
on the existing component now become visible. There are two 
types of attachments on the existing component: plane and axis 
attachments. 

Plane attachment - This is shown as an arrow. If you hover the 
mouse over this attachment, the attachment on the new 
component is aligned in the same plane as the existing 
attachment. When you click the mouse, the new component is 
placed at the cursor position and aligned with this plane 
attachment. 

Axis attachment - This is shown as an arrow with a circle at the 
bottom. If you hover the mouse over this attachment, the 
attachment on the new component is fixed on the axis 
attachment. If you click the mouse anywhere on the screen and 
don't hover over another attachment, the new component is 
snapped onto this axis attachment. 

3 Once a new component is added to the existing component, 

another one appears. Cancel the command by clicking ; the 
new component disappears. 

The component is also registered as an assembly component. 
You can create further copies of this component or modify it 
using Assembly modelling techniques (see page 7). 

Apply - This creates the component on the screen. 
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Component Wizard - Custom tab 
Use the options on the Custom tab to change the standard 
dimensions.  

 
Use the options like Plate width, Plate Length and Thickness to 
change the dimensions. The exact parameters that are displayed in 
the Custom tab reflect the type of component you are defining. 

 
Material - Select the International Standard number for the material 
to be used. 
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Click on the coloured bar to reveal the fields. 

 
To hide the fields, click the coloured bar again. 

Function - The option you select specifies which component you 
intend to position the component on. Either select an option from 
the drop down list or use the default option (Selected on model) to 
pick the component in the model. 

Position the component - If this option is selected and you click 
Apply on the browser page, the object is added to the assembly. 
You can then position it using the following technique from 
Assembly modelling. 

1 Select an existing component. Valid attachments are now visible 
on the new component. 

2 Click an attachment on the new component. Valid attachments 
on the existing component now become visible. There are two 
types of attachments on the existing component: plane and axis 
attachments. 

Plane attachment - This is shown as an arrow. If you hover the 
mouse over this attachment, the attachment on the new 
component is aligned in the same plane as the existing 
attachment. When you click the mouse, the new component is 
placed at the cursor position and aligned with this plane 
attachment. 

Axis attachment - This is shown as an arrow with a circle at the 
bottom. If you hover the mouse over this attachment, the 
attachment on the new component is fixed on the axis 
attachment. If you click the mouse anywhere on the screen and 
don't hover over another attachment, the new component is 
snapped onto this axis attachment. 

3 Once a new component is added to the existing component, 

another one appears. Cancel the command by clicking ; the 
new component disappears. 

The component is also registered as an assembly component. 
You can create further copies of this component or modify it 
using Assembly modelling techniques (see page 7). 

Apply - This creates the component on the screen. 
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Component Wizard - Key & Trim tab 
The Key & Trim tab displays the parameters for the single or double 
slot keyed pins that are available for plain, stepped, blade ejector 
pins and ejector sleeves. The parameters that are displayed are 
specific to the type of component you are creating.  

The parameter labels refer to the dimensions on the graphic in the 
dialog. 

  
Keying - Click the coloured bar to display the options. 

 
Specific parameters for Ejector pin - Click the coloured bar to hide the 
options. 

Trim pin - (Only available for ejector pins, sleeves and blades) By 
default, ejector pins and blades are now trimmed when you 
create them. Turn the option off if instant trimming is not 
required. 

Trimming offset - (Only available if Trim pin is selected) The 
offset allows the pin to be trimmed so that it projects from the 
product surfaces. This compensates for the pressure on the pin 
when the mold is closed and ensures that when the mold is 
closed, the pin is never lower than the product surfaces.  This 
helps create a good finish to the molded part. 

Function - The option you select specifies which component you 
intend to position the component on. Either select an option from 
the drop down list or use the default option (Selected on model) to 
pick the component in the model. 
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Position the component - If this option is selected and you click 
Apply on the browser page, the object is added to the assembly. 
You can then position it using the following technique from 
Assembly modelling. 

1 Select an existing component. Valid attachments are now visible 
on the new component. 

2 Click an attachment on the new component. Valid attachments 
on the existing component now become visible. There are two 
types of attachments on the existing component: plane and axis 
attachments. 

Plane attachment - This is shown as an arrow. If you hover the 
mouse over this attachment, the attachment on the new 
component is aligned in the same plane as the existing 
attachment. When you click the mouse, the new component is 
placed at the cursor position and aligned with this plane 
attachment. 

Axis attachment - This is shown as an arrow with a circle at the 
bottom. If you hover the mouse over this attachment, the 
attachment on the new component is fixed on the axis 
attachment. If you click the mouse anywhere on the screen and 
don't hover over another attachment, the new component is 
snapped onto this axis attachment. 

3 Once a new component is added to the existing component, 

another one appears. Cancel the command by clicking ; the 
new component disappears. 

The component is also registered as an assembly component. 
You can create further copies of this component or modify it 
using Assembly modelling techniques (see page 7). 

4 Apply - This creates the component on the screen. 
 

Component Wizard - Clearances tab 
The Clearances tab displays the parameters that are required for 
components such as guide pillars, ejector pins, screws, sprue 
bushes, support pillars and dowels. The parameters that are 
displayed are specific to the type of component you are creating.  
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The parameter labels, for example C1, C2, C3 and C4, refer to the 
dimensions on the graphic in the dialog. 

 
Automatic clearances - If this option is selected, the mounting 
clearances C1, C2 and C3 have predefined values based on the 
following: 

 Body diameter and Body length dimensions (selected on the 
Standard tab. 

 Stroke dimension. 

If Automatic clearances is deselected, the parameter boxes are 
available. Enter the clearances that you require. 

 
 

Component Colour scheme 
To ensure clarity when designing both the 3D model and 2D 
drafting, the component colour scheme uses the following rules: 

 With the exception of plate and riser components, the wireframe 
colour of components use the colour of the component material. 
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 The wireframe colour of plate and riser components is set to the 
default colour of the components for the colour scheme. 

 Plate components are assigned a material that is 90% 
transparent, allowing you to see clearly all the components and 
features inside the plates. 

 

Assembly options 
There are four pages of Assembly options: 

 General options (see page 138) 

 Graphics options (see page 141) 

 Tree options (see page 142) 

 Component Libraries options (see page 144) 
 

General options 
Use this page to define the operation of assembly modelling. 

1 Select Tools > Options. This displays the Options dialog. 

2 Expand the Assembly branch and select General. 

 
3 Make the required changes to the options on the dialog. For 

further details, see Options > General (see page 139). 

4 Click OK.  

The dialog is closed and the new settings will now be used. The 
current model and any new model you create will use these 
settings. However, when you open existing models, they will 
open with the settings saved with the model. 
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Options - General 
Use this page to define the operation of assembly modelling. 

 

Assembly General Options 
This group of options control the general operation of assembly 
modelling. 

Auto attachment factor — Enter the factor by which the original 
bounding box of the geometry of the component grows. If an 
attachment is outside the new bounding box, it is not included in 
the component definition. 

 

 Original bounding box of the 
geometry of the component 
definition 

 Bounding box when an Auto 
attachment factor of 2 is applied. 
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Show New Assembly dialog box — Select this option to display the 
Create New Assembly dialog when you create a component and there 
is no current assembly. The Create in new model option in the Create 
New Assembly dialog is disabled because you can use the solid from 
the current model. 

Deselect this option to create the new assembly automatically with 
a default name. Description and Category Name are set to <none>. 

Use the solid level to create a component — Select this option to 
create components on the level of the source solid when creating 
components directly from the solid. When you modify a component, 
the solids of the component definition are moved onto the level of 
the component being modified. When converting components to 
solids, the solids are created on the component level. 

Deselect this option to create components on the current level. 

Alter conflicting relations on general editing — Select this option to 
alter or remove a relationship to allow a component to be 
repositioned. Deselect this option to keep all the relations and 
restrict the new position of the slave component. 

Show Generate Power Features dialog box — Select this option to 
display the Generate Power Features dialog when you select Generate 
Power Features from the source or target component popup. 

If deselected, the dialog is not displayed and the effect of selecting 
Generate Power Features from the component popup is one of the 
following: 

 If you select a target component, Generate Power Features 
generates Power Features for all the source components that 
intersect with the target. 

 If you select a source component, Generate Power Features 
generates Power Features for all the target components that 
intersect with the source. 

 This option also controls the behaviour of the Remove Features 
dialog. 

Keep orphaned power features — When you delete a component that 
is the only one associated with a particular power feature, the 
power feature is orphaned. 
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If selected, the orphaned power feature is marked as out of date. 
The orphaned power feature is removed from the tree when you 
select Generate Power Features from the assembly context menu. 

 
If deselected, the orphaned power feature is removed from the 
assembly tree. 

Create local copy of component definition — This controls the setting 
of Create local copy of component definition on the Add Component 
dialog. 

If ON, the option on the Add Component dialog is always set ON. 

If OFF, the option on the Add Component dialog is always set to 
OFF. 

Text Generation from Properties 
Use these options to customise the format of the text that is 
generated from the component definitions. 

Format of string — Enter the format of the text that is generated 
from the Component properties. This text is used when displaying 
the Component properties on the model. The default setting is 
Property Name : Value. 

Unnamed Property String — Use this option to decide the properties 
that have their name displayed. For each prefix in this list, the value 
of the property is included, but the property name is not displayed. 

 

Graphics options 
You can select which of assemblies are visible using the Tools 
menu. 

1 From the Tools menu, select Options. This displays the Options 
dialog. 
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2 Select Assembly, followed by Graphics. 

 
3 Select the Visibility from the list: 

Active Assembly — Only the current active assembly is visible. 

Top Assemblies — Only the top assemblies (those that are not 
inserted into other assemblies) are visible. 

All Assemblies — All Assemblies are visible. 

4 Update the Turn on/off automatic changing of views option if 
required. Select the option to change the views automatically 
when a new component is created. Deselect the option to keep 
the views even if the component that is created is outside the 
view bounding box and therefore invisible. 

5 Click OK.  

The dialog is closed and the new settings are used. The current 
model and any new model you create use these settings. 
However, when you open existing models, they open with the 
settings saved with the model. 

 

Tree options 
Use this page to control when objects in an assembly are 
highlighted. 

1 From the Tools menu, select Options. This displays the Options 
dialog. 
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2 Select Assembly, followed by Tree. 

 
3 Select the options you require. 

Off — Objects in the assembly are not highlighted by selecting an 
item in the assembly tree. 

On mouse moving — The object under the cursor in the assembly 
tree is highlighted in both the tree and graphical window. The 
item under the cursor is drawn in a bounding box around the 
highlighted component. 

If the assembly is displayed in shaded mode, the bounding box is 
drawn as a transparent shaded box. A dashed wireframe box is 
used if the assembly is displayed in wireframe mode. 

 
On item selection — The object you select in the assembly tree is 
highlighted in the graphical window. The object is not highlighted 
when the cursor is moved outside the tree browser. 

Select components in graphics when selected in tree — If ON, a 
component selected in the assembly tree is also selected in the 
model. If OFF,  a component in the assembly tree is highlighted 
in the model. The default setting is OFF. 
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4 Click OK. The dialog is closed and the new settings are now used. 
The current model and any new model you create use these 
settings. However, when you open existing models, they open 
with the settings saved with the model. 

 

Component Libraries options 
Use these options to define how component libraries are used. 

1 From the Tools menu, select Options. This displays the Options 
dialog. 

2 Select Assembly, followed by Component Libraries. 

 
This model is a component library — If ON, the active model is saved 
as components in the component library. 

If you select this option, 

1 A thumbnail image of the definition is saved in the model. 

2 The Query for deleting unused component definitions is not 
displayed. 

3 You can use the Open Component Library dialog and the 
Component Library window to create components. 

For further details, see Component Libraries (see page 31). 

Search paths for component libraries — This window shows the list of 
paths that are searched for component libraries.. 
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The path to the component library that was used by an assembly is 
stored with the assembly. If, when required, the component library 
is no longer at the stored location, the paths that are specified in 
this window are searched for the required component library. When 
using the default settings, no search path is initially included. 

You can change the search list by using the associated buttons. 

 — Click this button to add a new path to Search paths for 
component libraries using the Browse For Folder dialog. Select the 
path to add to the list of search paths. 

 — Click this button to removes selected path from the list. 

 — Click this button to move the selected path up in the 
search order. 

 — Click this button to move the selected path down in the 
search order. 

To replace a selected path: 

1 Double-click a path in the window.  

2 Select a replacement path from the Browse for Folder dialog 

Add thumbnails of the active model definitions — If ON, the 
thumbnails of the component definitions for the active model are 
added to the component library window when opening a model, 
updating a model or closing a model. The thumbnails of the old 
active model are removed from the window. 

This model is a protected original — This gives more control over 
updating rights on the standard component libraries. If ON, you 
cannot 

 update the original definitions from the dependent models. 

 save the updated model to the protected original. You are 
given the opportunity to save the model to another name, 
using Save As. 

Default view direction for thumbnails — Select a view direction from 
the list to set the orientation of the component definitions that are 
shown in the component library window.  
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